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Tutorials for Leapfrog Geo 4.1

These tutorials introduce basic conceptsin Leapfrog Geo, such as setting up a project,
importing and working with data and building simple geological models. Download the tutorial
data at http://help.leapfrog3d.com/Tutorials/Geo/4.1/en-GB/LeapfrogGeoTutorialData.zip.

The data for the first tutorial is a Leapfrog Geo project that includes a series of saved scenes that
are used to introduce different aspects of using Leapfrog Geo. For subsequent tutorials, you will
import data and use it to build geological models.

The tutorials are:

o Tutorial 1: Introduction to Leapfrog Geo

Tutorial 2: Modelling Veins

o Tutorial 3: Modelling a Syncline in a Series of Deposits

o Tutorial 4: Modelling a Complex Intrusion

o Tutorial 5: Building a Geological Model From a Map

When using Leapfrog Geo, you can find more information on the tools available by clicking on
the Help button that appears in many windows:

& MNew Geological Model

General

Base lithology column: | Lithology | = |
Surface resolution: 2000.0 : [ Adaptive

Model Extents
Minimum Maximum

X(Fast): [2223800.7845443 |3 [2312060.5626014 3

¥ (North): [3604185.082478 | 5710922.8404842 2|

ZHa) (1320 3] [z1320 B

| Enclose Object +

Name: [GM l

[ ﬁﬂe\p | [ xgancal | @QK |

Pressing the F1 key also displays help for the current window.
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Tutorial 1: Introduction to Leapfrog Geo

In this tutorial, we will work through an existing Leapfrog Geo project. This project includes a
series of saved scenes that demonstrate different aspects of using Leapfrog Geo.

1. Unzip the folder that contains the tutorial data and copy it to your hard drive.

The project file for this tutorial can be found in the Introduction folder and is called “Leapfrog
Geo Tutorial”.

2. Launch Leapfrog Geo.
The main window will appear with the Projects tab displayed.

The Recent projects list is a useful way of accessing the projects you are regularly working in.
Below the Recent projects list, the Search folder is displayed. This is useful if you have one
folder in which you will keep most of your Leapfrog Geo projects. Click on the folder button (&)
to change the Search folder. When there are Leapfrog Geo projectsin the Search folder,
thumbnails for them will be displayed.

3. In the Projects tab, click Open Project File:

v | B8 Projects | B Scene View

%g Project Tree g
|_] New Project...

[~ Open Project File...

Recent projects | Clesr

4. Navigate to the folder where you saved the tutorial project files and click on the “Leapfrog
Geo Tutorial.aproj” file.

The project will be opened and Leapfrog Geo will display the Scene View tab.
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The Leapfrog Geo Main Window

The Leapfrog Geo main window is divided into three parts:

& Leapfrc

T Project Tree 2y g? Lock v w K @ [K| \\ g f
A A Topographies o
[ Y Topography

P [ Draped GIS Objects

[ 3 E‘ Gl Data, Maps and Photos
W [ Drillhole Data
P |11 Drillholes

P [ Planned Drillholes
ﬁ" Drillhele Correlation
E‘ Points =
E‘ Polylines
B [F) Structural Modelling g
[ E‘ Meshes % X, =
¥ [ Geological Models m/ SR
P (@ 6Mm
P [ Static GM
E‘ Numeric Models i e B8
[ Combined Medels <@ 4 Topography 3 |&Flat col..~ l:l =
[F1 Block Models GIS data: E
v E‘ Saved Scenes and Movies . . Farmland detail x
%, ™ 1, Maps and tepography Py . Tekapo %
™ 2, Displaying drillhole data
%, ™ 3, Defining the medel bounda
P4 Cicinathraunh a aenlnnica
v

Plunge +38 e
Azimuth 226

= 02500 5000 75000000
e

o

=

18 Full Acceleration 65FPS  §HZ-Scale 2.0

The Project Tree contains all the data in the project and tools for working with that data. When
you want to change how this data is used in the project, work with the objects in the project
tree.

The Scene View tab displays a 3D representation of selected objects from the project tree.
Changing how you view objects in the scene window does not change those objects in the
project tree.

Tools for changing the appearance of data in the scene window are available in the Shape List
and the Shape Properties Panel. Changing the appearance of these objects does not change
those objects in the project tree.

The series of folders in the project tree are used to organise objects such as maps, imagesand
data setsinto categories. These folders also provide tools that let you import information into
the project and generate models. Right-click on each folder to view the actions you can
perform using that folder.

You can add objects to the scene window by dragging them from the project tree. You can
temporarily hide them in the scene or remove them altogether using the controls in the shape
list.
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The current viewing angle and scale are displayed in the lower righthand corner of the scene
window. You can interact with the scene using the mouse or the keyboard:

Action

Changing the
viewing angle

Mouse

Click and drag to rotate the
scene

Keyboard

Press the arrow keys to rotate the scene

For smaller steps, hold down the Shift key
while pressing the arrow keys

Zooming in and
out of the scene

Use the scroll wheel

Hold the right mouse
button while moving the
mouse

Press the Page Up or Page Down keys

For smaller steps, hold down the Shift key
while pressing the Page Up or Page Down
keys

Click and hold both mouse

objectin the
scene

Click both mouse buttons
together

Panning the buttons, then drag Hold down the Alt key while pressing the
scene arrow keys

Hold the scroll wheel and

drag
Centre an Click the scroll wheel

Practise rotating the scene using mouse, arrows and modifier keys. The viewing angle and scale
in the lower righthand corner of the scene window change as you rotate the scene.

2 o

Plunge +38 @
Azimuth 226

0 2500 5000 75000000

Toward the bottom of the project tree, the folder Saved Scenes and Movies contains a series of
scenes we will look atin order to understand how Leapfrog Geo projects work.

Saved scenes provide a stable point of reference in a project and can explain important
aspects of the project. Saving a scene does not save copies of the objects in the scene, it
simply saves settings relating to how the objects are displayed. Deleting objects from the
project will not preserve those objects in any saved scenes.

The project was last saved with the first scene, “1. Maps and topography”, displayed. If you have
changed the scene, you will need to redisplay the opening scene.
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The Leapfrog Geo Main Window | 5

1. Right-click on the “1. Maps and topography” scene in the Saved Scenes and Movies folder
and select Display:

v E‘ Saved Scenes and Movies ‘
%, ™ 1, Maps and topography

Open
%, ™ 2, Displaying drillhole dat =pe
. . Display
%, ™ 3, Defining the model boy —— L\\e
T P 4, Slicing through a geold Rename... F2
e, ® 5, Using the moving pland & Delete.. Delete —
e ® R llsinn the miler tn messiee in 2|

The scene will be updated to show a “Topography” object and two images:

v | BB Prcue;j.:: @SceneV\ewl .
F - WA F DN S

orth (¥)

%
+2310000
e
/
v

7,

Plunge +38 e
Azimuth 226

o 2500 5000 75000000

—
= -
=

@ {3 Topography ® [@Fatcol.~|[ |l ——1 | |&
GIS data: ——{
@ [ Farmland detail 4 gy
@ @ Tekzpo 4 —{
m ] »
'R Full Acceleration 23FPS  fZ-Scale20

All objects in the shape list have a button (¥) that will remove the object from the scene. Most
objects also have a visibility button (®) that can temporarily hide that object in the scene. Itis
often easier to make an object temporarily invisible than to remove it from the list. Some objects
have an edit button () that you can click to begin editing the object.

The shape list also contains options for changing the appearances of the object in the scene.
For the images, you can only change the opacity by adjusting the slider. For the topography, the
GIS data dropdown list provides additional display options.

2. Clickon the GIS data dropdown and select None:

@ 4 Topography ® IE
= .

@ [@ Farmland None I,\\e

@ TEkapD Views N

Maps and Photos ]
GIS ohjects v
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The scene will be updated so that the Topography object is displayed using the Flat colour
option. In the case of surfaces, different colours will be assigned to each side. The Topography
hasan “Above” colour (yellow) and a “Below” colour (grey):

@ 3 Topography ] & Flat col...~ @ v/ b
GIS data:

@ @ Farmland detail b4

- @Tekapu b4

The colour used to display an object can be changed by clicking the colour chip. In the window
thatappears, you can set a new colour or select from predefined colours:

Edit Above

‘ J Hue: |43 : Red: (2535 |4
Saturation: |235 . Greem: 235 |+
‘ Value: |235 |5 Blue: [0 &
Color name: | yellow J
Palette:
H EEEE N
4al | | BN
;;:ﬂe\p Random Revert xglose

Many objects can also be displayed using other available data. For example, the Topography
includes elevation data.

3. Click on Flat colour to view other display options:

@ {4 Topography 32 [@Fiatcol..t /P b b

GIS data: & Flat coldtir
@ @ Farmland detail 3¢ | *%- Blevation
® @Tekapn €

Changing how you view objects in the scene window does not change those objects in the
project tree.
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4. Click on the (¥) button for each of the images in the shape list:

-~ [Brros | @ scencvie |

The Leapfrog Geo Main Window | 7

F - WNEF R\ &S

2310000

)
iast
4

Remove from scene

@ 43 Topography R [@Ratcol.~|[ ([l ——C ) b
WJ Select -]

@ . Farmland detail E ="

@ [ Tekapo T

1]

Plunge +38 Q
Azimuth 226

Z500 5000 75000000

8| No selection

%, +2310595.44, +5708228.81, +698.94 Full Acceleration

14FPS  Z-Scale 20

Removing objects from the scene by clicking the (¥) button does not remove them from the

project.

Only the topography remains in the scene.

The Z-Scale button in the lower righthand corner of the main window lets you set a value
greater than 1.0 for the z-axis relative to the x- and y-axes. Thisis useful when the area under
studyis very planar and extends over a wide area. In such cases, scaling the Z-axis can
accentuate the distribution of data along the z-axis.
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5. Click the Z-Scale button and experiment with different z-scale settings to see the effects:

¥ | BB Projects | @ Scene View

PR AN BIINENE

+2300000
2295000
arth ()

42305000

e

& Scale 7 Ais

Z Avisis (20 | times the X and ¥ axes.

East ()
\

Plunge +38 0
Azimuth 226

a 2500 5000 75000000

® J Topography
GIS data: | Select -

T, +2304619.79, +5709013.20, +1431.49 Full Acceleration 100+ FPS ﬁbZ-Scale?_‘O
il N
|3

6. Return the Z-Scale setting to 2.0.

Displaying GIS Data
The GIS data dropdown listincludes a number of GIS data objects and images that have been

imported into the project. There are three ways to view imported GIS data and images:

« Display the objectsindependently of the topography. To view data in this way, either drag
and drop the object into the scene or right-click on the object and select View Object.

« Display objects draped on the topography.
« Display objects as part of a custom topography view.

To display GIS data with the topography:

1. Fromthe shape list, select the GIS data dropdown list and select GIS objects, then the lake_
bdy line.

© 2017 ARANZ Geo Limited



Displaying GIS Data |9

The topography will be displayed with the GIS line draped on it using the Flat colour option:

- eﬁcene\t’\ew
F - WNF R\ &S

Plunge +38 o
Azimuth 226

1] Z500 5000 75000000

GIS data: lake_bdy

‘
-------------- e 30|z

LN Full Acceleration S4FPS @ Z-Scale 2.0

The lake_bdy object can also be displayed using the columns available in the data table, which
can be selected from the view list:

|¢° & Topography ® bbb

‘ Flat colour
s ELEVATION
A shapelD

(B WATER_CONF

The GIS data list also contains options for creating and displaying custom topography views:

= & Topogaphy X @rao] M —— bb |

Edit views...
Maps arid Photos
GIS objects

Topography + GIS data

Topography contours

2. Click on the GIS data dropdown list and select Views, then the “Topography + GIS data”
option.
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The Topography will be displayed with map images and a number of GIS data objects draped

onit:

- [ 9 screven |

Flu-WNE BN &S

o
=1
=1
w
@
o

3 (& Flat col..~ l:l = | bbb

Azimuth 226 0

Plunge +38
1] 2500 5000 75000000

@ {3 Topography GIS data: Topography + GIS data
GIS data: | Topegraphy +...~ | L
i »
T, +2283743.25, +5694297.44, +512.92 Full Acceleration 9FPS  fZ-Scale2D

3. Click on the GIS data dropdown list and select Views, then the Edit views option.
4. In the window that appears, experiment with adding and removing layers and changing how

they are displayed:

& Edit GIS Views

GIS views: [Tﬂpﬂgraphy+ GIS data | | |Rename| | New..| |Delete|

Ayailable layers: Current layers:

? North_boundary ‘::E’ river_cl & Flat colour = width: 1.00 =

57 river_bdy . river_seed & Flat colour = l:l sizet 4,00 e 1

. lake seed 57 lake_bdy & Flat colour = l:l width: 1.00 = X

0 river_poly "7 lake_poly b Flat colour ~ I:l —_—

"-\1“ Tepegraphy contours 0 scree poly b Flat colour ~ I:l s
% shingle_poly b Flat colour ~ I:l el
Farmland detail s
Tekapo i
Area map .

| Add E‘V‘ | $ Remove J} Lower
Hnep | 9 Revertall | | P Close

The scene will be updated as you make changesin the Edit GIS Views window.
5. When you have finished, click Revert All to discard your changes, then click Close.
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How Objects are Organised in the Project Tree

The way folders and objects are organised in the project tree lets you reveal or hide information
about an object to focus on objects you are currently working with. This is also useful when you
are exploring a project and want to determine how something was put together. Leapfrog Geo
projects can be complex and the number of objects in the project tree can seem overwhelming.
The arrows next to objectsin the project tree let you reveal or hide an object’s details to focus on
objects you are currently working with. Let's look at three objects in this project to see how this
works, the Topography object, a geological model and a static model.

In Leapfrog Geo, the topography is used to define the elevation of the ground’s surface. The
topography can be defined using a single digital terrain model (DTM), but often data from
several sources is combined to ensure the data is consistent.

The topography is used as the upper boundary for geological models and to position

GIS data. As a result, changing the topography will cause geological models to be
recomputed and GIS data to be repositioned. This can be time-consuming, which is why it is
best to define the topography before GIS data is added to the project and before any models
are created.

To determine how the topography was created, we need to find the topography in the project
tree.

1. Right-click on the Topography object in the shape list and select Go to Project Tree:

* | BB Projects | B Scene View
éj Look = w K ﬁ L\} R 13 éys

52 Goto Project Tree D?
Visible

Qpacity

Slice Mode

Display
D Colour

. Back Colour

Elev Gé;)

=)
=1
=1
=1
@

Faces s

0] Edges . ¥

Smooth Faces

3£ Remove i Flunge +38 o
Azimuth 226

Remove All Invisible 0 5000 10000 15000000

Eﬂ Meve List to Right

EI Put List in Separate Tab
@ g4 Topography — o | Y é Topography
615 data:

Slice mode: | From Scene v

L &3 Full Acceleration & Z-5cale 2.0
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The Topography object (4) in the Topographies folder is selected:

& Leapfrog Geo Tutorial - Leapfrog Geo

?;g Project Tree g,
> A Topography o
B [ Draped GIS Objects
> E GIS Data, Maps and Photos
¥ [ Drillhole Data
P |}] Drillholes
P [ Planned Drillholes
ﬁ" Drillhele Correlation

Objects displayed in bold in the project tree are those objects visible in the scene.
2. To see how the Topography was created, click on the arrow to expand it.

The Topography was created from an imported DTM:

@ Leapfrog Geo Tutorial - Leapfrog Geo

g Project Tree a,

¥ £ Topegraphy 5
£ Tekapo DTM
| 3] Draped GIS Objects
B [ GIS Data, Maps and Photos
¥ [ Drillhole Data
> ”l Drillholes
P [ Planned Drillholes
E‘ Drillhole Correlation

The object is hyperlinked because it is stored elsewhere in the project tree.

3. Click on the hyperlink to view the source object:

& Leapfrog Geo Tutorial - Leapfrog Geo

%g Project Tree [ :;‘
¥ [ Topographies
¥ & Topography
2 Tekapo DTM
P [ Draped GIS Objects
P [ GIS Data, Maps and
¥ [ Drillhole Data
P 111 Drillholes
P [ Planned Drillholes
E‘ Drillhcle Correlation
E‘ Points
E‘ Polylines
[ 3 E‘ Structural Modellin
W [ Meshes
&2 Tekapo DTM
¥ [ Geological Models

The imported DTM is stored in the Meshes folder.

Now let's look at the components of a geological model.

4. Click on the Clear scene button (¥).

The Geological Models folder contains a model called "GM".
5. Drag the "GM" model into the scene.

6. In the project tree, click the arrow for the model to expand it.
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How Objects are Organised in the Project Tree | 13

7. Click the arrows for the model's Boundary, Lithologies, Surface Chronology and Output
Volumes objects.

og Geo Tutorial - Leapfrog Geo

¥ | B8 Projects | [ Scene View

FluWNF[RN &S

%g Project Tree
¥ [ Geological Madels
¥iicm
¥ & Boundary
(D GM Extents
P~ Topography
P | Morth_boundary
&3 Fault System
¥ = Lithologies
[y Lithology
¥ @ Surface Chronology
P @ Alluvium contacts
P @ Alluvium - Coarse Sand conf
P @ Gravel - Alluvium contacts
B & Glacial Till - Gravel contacts
B Lower Gravel - Glacial Till co
b Aquifer Miocene Alluvium -
P % Basement Granite contacts @ (7 6M 3¢ [(@om - |[ Edit Colours | Y = {%GM
¥ [ Output Volumes =
& Alluvium Slice mode: | From Scene v
& Coarse Sand Fill Slicer
&2 Gravel
& Glacial Till
82 Lower Gravel
8 Aquifer Miocene Alluvium
82 Basement Granite -

e

Plunge +20 @
Azimuth 030

500 1000 1500 z000

L8 .@J Full Acceleration 90 FPS  $Z-Scale2D

The five objects underneath the geological model “GM" represent the five basic parts of a
geological model:

« The Boundary object defines the outer limits of the geological model. Itis made up of a basic
“GM Extents” object, the Topography and a “North_boundary” object.

o The Fault System object defines faults and their interactionsin the geological model. For
this model, no faults are defined and so the object is empty.

« The Lithologies object defines the lithologies in the model. Because the model was made
from drillhole data, this object is hyperlinked to the imported drillhole data.

« The Surface Chronology object defines the structure of the model's contact surfaces. The
contact surfaces are used to divide the model Boundary into the Output Volumes.

« The Output Volumes folder contains the generated units (outputs) that make up the
geological model.

8. Expand the objects under the Boundary object to see the data used to make the extents:

¥ @ Boundary
() GM Extents
¥ = Topography
ﬁ Topegraphy
v i North_boundary
¥ 01 North_boundary vertical v
* Morth boundary

The Topography objectisincluded as the model's upper boundary. The “North_boundary”
object was created using a GIS data object in the GIS Data, Maps and Photos folder. Clicking
on the hyperlinks will locate the object from which the extent was created.

Also in the Geological Models folder is another object, called "Static GM".
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9. Expand the Static GM model in the project tree:

¥ [ stotic GM
g Legend
P &F Boundary
& Fault System
B & Surface Chronclogy
| ] Qutput Volumes

The Static GM model is made up of the same objects as the GM model, but most of these
objects cannot be edited. You can change the colours used to display the output volumes by
clicking on the Legend object.

10. Right-click on the Static GM model and select Properties.

In the window that appears, we can see the date the static model was created and information
about its volumes:

@& Properties - Static GM

General Processing  Errors
Created On: 1/09/2016

Volumes:

Alluviurm: 679,820,000
Coarse Sand: 137,410,000
Gravel: 244,270,000
Glacial Till: 224,940,000
Lower Gravel: 646,530,000
Agquifer Miocene Alluvium: 36,217,000
Basement Granite: 1,660,600,000

The Properties window is a useful way of finding out more information about objectsin the
project. The information available in the Properties window depends on the type of objectand
is available for most types of objects.

The Static GM model is a static copy of the GM model. Models in Leapfrog Geo will be updated
when changes are made to the data objects used to create them. A static copy, however, isa
snapshot of a model that does not change, even when changes are made to the data on which
the original model was dependent. A static copy is a useful way of storing historical models and
comparing models.

Exploring Additional Scenes

There are other saved scenes in the project that demonstrate different aspects of using
Leapfrog Geo, including:

« Displaying drillhole data

o Defining a model'sboundary

« Using theslicer to slice objects in the scene
o Using the moving plane to measure trends
o Using the ruler to measure distances

« Creating and evaluating cross sections
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Explore these saved scenes to see how different objects are managed in Leapfrog Geo. You can
display each saved scene by dragging it into the scene window. You can find out more about
each scene by viewing the comments. To do this, right-click on the saved scene in the project
tree. Any comments on the scene will be displayed along with the right-click menu:

¥ [ Saved Scenes and Movies

. ™ 9. Maps and topography
P Displaying drillhcle data
L open

%, ™ 3, Defining the medel bouni ) ¥ Comments ab or click to edit
e ® 4, Slicing through a geolagil & Display Changing how objects are displayed is useful in analysing data.
&, ® 5, Using the moving plane Rename. F2 Here, geology intervals are shown with contaminant intervals
‘ i inside.
%, ™ 6, Using the ruler to measur| & Delete.. Delete

T, ® 7. Cross section with geological mad

3 E‘ Cross Sections and Contours

In the next tutorial, we will import drillhole data and use it to build a geological model.

© 2017 ARANZ Geo Limited



Tutorial 2: Modelling Veins

In this tutorial, we will use drillhole data to build two geological models of a series of veins and
the lithologies in which they occur.

« Forthe first model, we will build individual veins.
« Forthe second model, we will build the veins as part of a vein system.

This tutorial also includes an introduction to setting up project files, importing topographical
and drillhole data and setting up a topography.

Data for this tutorial can be found in the Veins folder.

Setting Up the Project

To start:
1. Launch Leapfrog Geo.
The main window will appear with the Projects tab displayed:

¥ | B8 Projects | [ Scene View

?;g Project Tree —
\J New Project...

[~ Open Project File...

Recent projects | Clear

2. In the Projects tab, click New Project.
The Create Project window will appear:

& Create Project

Mew project name: !_ |

Project file: [C1\UserS\Genlngist\LeapFrng Projects J

= Browse...

ﬁgan:el

3. Enterthe name "Veins tutorial” for the new project and click Browse to select a folder where
the project will be saved.

4. Click OKto create the project.
The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing an Aerial Photo

When first created, a project has only a basic set of X-Y-Z coordinates, and the coordinate
system used by the project is determined by the data imported to the project. Itis not necessary
to specify what coordinate system is used; however, it is necessary to ensure that data you
import into the project uses the same coordinate system. Often, the best way to set the
coordinates for the project as a whole is to import a map or aerial photo. Adding georeference
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data to a map will set the location of the map in three-dimensional space and set the
coordinates for the project. For this project, we will import a georeferenced aerial photo.

Data for this tutorial can be found in the Veins folder.

1. Right-click on the GIS Data, Maps and Photos folder and select the Import Map option:

al - Leapfrog Geo

* | BB Projects | @@ 5

g Project Tree 8, &3 ook w

[ Tepographies
[ GIS Data, Maps and Photos
¥ [ Drillhole Data Import Vector Data...
| rt 2D Grid...
[ Planned Drillholes ‘m“ = =
rt
[ Drillhale Correlation L L\)

[ Points New GIS Line.., v
[= Polylines Batch Import v
'E‘Stru(tura\Modellmg Set Clipping Boundary...
E‘ Form Interpolants

[F5) New Subfalder...
E‘ Stereonets

2. Inthe window that appears, select the file called orthophoto.tif, then click Open.
The Import Map tab then displays the image:

r 58 Projects | [ Scene View | "1 Import Map X

Name: [othophots “Ei 117 Crop Image @ [2s% [«] @ @ @ “Gmpot | T rHep

[[] Override georeference data from image

N @ Full Acceleration 20FPs  F7Z-Scale 10

In this window, you can enter georeferencing information foran image, if itis not included in

theimage. In this case, the image includes georeference data and nothing needs to be
changed.

3. Click Import to import the photo.
The imported photo will be saved in the project tree in the GIS Data, Maps and Photos folder.
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4. Display the photo by clicking on itand dragging it into the scene:

¥ | BB Projects | [ Scene View

Flo-WN® [N\ ® S

MNorth ()

East (X)

Plunge +20 @
Azimuth 030

0 1000 2000 3000

< O orthophoto P 22 orthophoto

Slice mode: | From Scene v

T IE3 Full Acceleration S0FPS  §Z-Scale 1D

The photo appearsin both the shape list and the shape properties panel. There are three shape
list controls for the image:

« Click the visibility button (®) to show or hide the photo.

« Click the (¥) to remove the image from the scene. This does not remove the image from the
project, as displaying objects and removing them from the scene do not change the data.

« Adjust the photo's opacity using the slider.

These controls appear for most objects when they are in the shape list. The visibility button (#)
and the opacity slider are useful when analysing relationships between objectsin the scene.

Setting the Clipping Boundary

The clipping boundary is the part of the project space in which processing is carried out. When a
project is created, Leapfrog Geo automatically sets the clipping boundary. As data isadded to
the project, the clipping boundary expands to fit that data. For models with large data sets,
setting the clipping boundary to a fixed size will reduce the amount of time Leapfrog Geo
required for performing calculations.

For this project, we will set the clipping boundary to the area indicated by the imported aerial
photo.

1. Press the D key to view the photo from above.
2. Right-click on the Topographies folder and select Set Clipping Boundary.
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The Set Clipping Boundary window will be displayed, together with controlsin the scene that
will help you to set the clipping boundary:

¥ | BB Projects | [ Scene View

AR ANE HITNENE P

@& Set Clipping Boundary

Morth () f

Clipping Boundary

Minimurm Maximum

X(Fast): [14706000 |2 [14722000

¥ (North): (33536000 |2 [53613000

Enclose Object «
38
st || Home

=

=
ng down
m

w

3750 5000

3,@ githophote & &F orthophoto

3. Use the handlesin the scene to adjust the clipping boundary so it is slightly smaller than the
photo.

4. Click OK.
Data subsequently imported into the project will be clipped to the clipping boundary.

Creating the Topography

In Leapfrog Geo, the topography is used to define the elevation of the ground’s surface. The
topography can be defined using a single digital terrain model (DTM), but often data from
several sourcesis combined to ensure the data is consistent.

The topography is used as the upper boundary for geological models and to position

GIS data. As a result, changing the topography will cause geological models to be
reprocessed and GIS data to be repositioned. This can be time-consuming, which is why it is
best to define the topography before GIS data is added to the project and before any models
are created.

For this tutorial, a single DTM file will be used to define a topography. It is called topo.asc.
To define the topography from the DTM:

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the topo.asc file and open the file.
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The Import Elevation Grid window will be displayed:

# Import Elevation Grid

Surface resolution:  |25.0 |

Clipping
Clipping will only be applied to grids
where north is vertical on the map.

Clip data to bounding box

Bounding box: | Clipping Boundary [~]

Margin: ID

No Data Handling

(®) Leave a gap
) Replacewith 0.0

Hame: [topo l

I @ﬂalp J ‘ xgaﬂcel Il |7 Import

3. Click Import.
The New Topography window will appear:

& New Topography

Enter a new topography name

[Tnpngﬁphy l

4. Click OKto accept the default name and create the topography.

5. Click on the Clear scene button (¥) to clear any objects from the scene window.
6. Drag the newly-created topography into the scene.

The topography is displayed in three dimensions:

& oy W F @%gﬁ

Morth ()

East ()

Plunge +20 @
Azimuth 030

0 500 1000 1500 z000

.4 Topearzely S rorcol - .Y ¥ 4 Topography
GSdatn [Select ] : '

'Y @ Full Acceleration T4 FPS QZ-SCEIE 1.0
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7. Select the imported photo from the GIS data dropdown list:

@ 4 Topography ¢ |&Flat ol ~ l:l bbb
GIS data: | Select M
MNone
Views v
Maps and Photos » @ orthophoto %
T S Full Acceleration 100+ FPS  FZ-Scale 1.0

The photo will now appear draped over the topography:

¥ | BB Projects | [ Scene View

F - W #FIBNFS

Morth ()

East ()

Plunge +20 @
Azimuth 030

1] 500 1000 1500 2000

@ {3 Topography % [@Fatcol.~|[ [/ b GIS data: orthophoto
GIS data; & orthophato - |

Importing the Drillhole Data

In Leapfrog Geo, drillhole data is managed using the Drillhole Data folder in the project tree.

Leapfrog Geo expectsdrillhole data that is stored in a collar table, a survey table and interval
tables. Each project can have only one set of drillhole data, made up of one collar file and one
survey file. Multiple interval tables can be imported, and a screens table can also be imported, if

available.
For this tutorial, there are three data files, which can be found in the Veins > Drillholes folder:

o collar.csv containsthe collar definitions.
« survey.csv describes the deviation of each drillhole.

« lithology.csv contains the interval definitions that describes the lithology.

To startimporting drillhole data:
1. Right-click on the Drillhole Data folder and select Import Drillholes.
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The Import Drillhole Data window will be displayed:

& Import Drillhole Data

Input Files
Collar: | — Browse...
Survey: J — Browse...
Intervals: = Add...
== Remove
Screens: J — Browse...
;;Help xgancel (ﬂlmpurt

2. For the Collar, click on the Browse button to locate the tutorial file collar.csv.
3. Click on thefile, then click Open.

When a collar file is added to the Import Drillhole Data window, Leapfrog Geo will look for
interval tables with names such as “lithology” or “geology” in the same location and will add
them to the Interval Tables list. If an interval table file is not automatically added to the list,
click Add and browse for the required file.

In this case, all files have been added to the Input Files list:

@& Import Drillhole Data

Input Files
Collar: [JserS\GEnlngist\Deslctnp\LeapFrng Geo Tutorial DEtE\VEH’\S\DfiHhﬂ|ES\(DHHI’.(SVJ — Browse...
Survey: [sers\Gea\Dg\st\Deslctop\Leapfrag Geo Tutorial Data\Veins\DriIIhoIes\suNay.(st — Browse...
Intervals: |...Geologist\Desktop'Leapfrog Geo Tutorial Data\Veins\Drillholes\litholegy.csv = Add...
= Remove
Screens: J | Browsg...
;;:HEIF' %Qancal Himport

4. Click on Import to start the process of importing data.
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First, the collar file is processed. Leapfrog Geo displays the data in the file and summarises how
each column will be imported:

& Import Drillholes

Progress: collar.csv > survey.csv > lithology.csv
File Data Column Summary
Hele ID w | East (X) v | North (¥} v | Elev (@) v | Max Depth Column Import As Import Name

1 holeid X ¥ = maxdepth holeid Hole D
2 |pcox? 1472095464 5357472687 70.71824268 1240633687 % East ()
3 PCOHE 1471974295 5357631804  79.26218851 1317264341 ¥ Nerth (V)
1 xaoxs 1471853127 5357790921  TN.17851999  110.6339749 2 E=5(Es
5 MFOHE 1472375749 5357434730 1329623683  195.0638123 maxdzpth Max Depth
6 MFOX2 1472254581 5357503856 1271608308 2133913362
7 MFOHE 1472133412 5357752973 1196066528  233.2682701
8 NVOX3 1472012244 535791200 82.82085840 2058401626
9 KKOH1 1471897134 5358063251  83.86602215 2127533356
10 NTOXS 1472534866 5357555007 2184323413 2077778623
11 NTOHG 1472413.698 5357715024 1737379586 28284
12 | LToXD 1472202.520 5357874141 1514568040 3112084466 e
13 BGOH? 1472171361 5358033258 1152233865 3123046808 Character encoding: | Auto (Windows-1252) v
14 BGOXT 1472056251 5350184419 82.40201991 3040561709 Wrique Ronw I: None =
15 DDOHA 1471947199 5358327625 733422800 2625827921
16 FLOX2 1472693.983  SISTETT.OTS 2194324134 303.8275788 Select Header Bow: |1 -
17 FLOHT 1472572.815 5357836192 2167382121 335266482 Import All Columns
18 TTOXT 1472451645 5357995300 2122772391 4183100888 S
19 YUOH3 1472330478 5358154426 1201085096 3745006984 b e

i}_;ﬂe\g %Qan(el .=; Next

Leapfrog Geo expects four columns for the collar data and attempts to match imported data
to these expected formats. For the collar file, Leapfrog Geo expects a drillhole identifier
(Hole ID) and the location of the top of the drillhole, in X, Y and Z coordinates. The Hole ID is
used to associate data in different tables with a single drillhole. Inconsistencies in the way
drillholes are identified isa common source of errors.

5. Leapfrog Geo has correctly mapped the data in the collar file to the expected format. Click
Next to proceed to the next file.
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The survey file data is displayed:

& Import Drillholes

File Data

holeid
PCOXT
MFOX2
NVOX8
NTOXG
NTOHE
LTOx0
BGOH7
BGOXT
DDOHA
FLOX2
FLOH7
TTOX1
YUOH3
YUOX5
UZOH9
FTOx4
FTOH2
MROX2

T R R - T T T R S

[ [ 2 aa]a[a]a]a
Wi e ~N|oy W hR W (N - S

t“; Help

Hole D

w | Depth

depth
0.0
0.0
0.0
0.0
0.0
0.0
00
0.0
00
0.0
00
00
00
0.0
0.0
0.0
0.0
0.0

Progress: collar.csv > survey.csv > lithology.csv

= | Dip

dip

w | Azimuth
azimuth
0.0
0.0
0.0
0.0
0.0
0.0
00
0.0
00
0.0
00
00
00
0.0
0.0
0.0
0.0
0.0

-

Column Summary

Column Import As Import Mame

holeid Hole ID

depth Depth

dip Dip

azimuth Azimuth
MName:
Character encoding: | Auto (Windows-1252) -
Unique Row ID: [Nune -

[l Megative Dip Points Down

Select Header Row: [1 -

Import All Columns

P+ Date and Time Formats
~| P CSY characters

‘%gance\ !.t_n Previous

I
1=
2

Leapfrog Geo expects four columns for the survey data, a Hole ID and deviation depth,

azimuth and dip.

6. Leapfrog Geo has correctly mapped the data in the survey file to the expected format. Click

Next to proceed to the next file.

The interval table is displayed. The “lithology” column has been correctly mapped as lithology
data, but the “veins” column has not been mapped.
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7. In the Column Summary, click on the dropdown list for the “veins” column and select
“Lithology”:

Progress: collar.csv > survey.csv > lithology.csv
File Data Column Summary
Hole ID w | From v | To ¥ | lithology ¥ | Not Importeds Column Import As Impert Name
1 holeid from to lithology “veins” Lithology holeid Hole [D
2 | AEOX1 0 23,341 Schist A& ‘veins® Category from From
3 | AEOX1 98.341 113.152 Vein C veins® Text ta To
4 ARt 113152 120525 Schist A veins® Numeric lithology Lithology lithology
5 | AEOXT 120525 135.206 Vein A veins” Time Stamp veins Not Imported
6 | AEOX1 135.206 200431 Schist A veins® Date
“veins® URL
7 | AEDX1 200.431 223737 Schist B
8 AEOX1 223737 232761 Vein B Not Imported
9 | AEOX] 232,761 270,098 Schist B Hole ID
10 | AEOX1 270.098 m.a7 Vein D Erom
11 | AEOX1 m.a7 346.287648 Schist B To
Mame: [Iithology
12 | AYOH2 0 135371 Schist A Custom Name...
13 | AYOH2 135371 360.6982176 Schist B ; Character encoding: | Aute (Windows-1232) v
14 | AYOXE 0 11.14 Cover Cover Unique Row [D: [Nnne -
15 | AYDX6 11.14 172338 Schist A Schist A
16 | AYOXE 172,338 280.3131091  Schist B Schist B Select Header Bow: |1 z
17 | BGOHT ] 11.387 Cover Cover Import All Columns
18 | BGOHT 11.387 150,094 Schist A Schist A S
19 | BGOHT 150,094 318.3046808  SchistB Schist B e
gﬂe\p &Qancel ‘; Previous :f? Skip dv FEinish

The Column Summary is updated to indicate that the “veins” column will be imported as
lithology data:

Column Summary

Column Import As Import Name
holeid Hole ID

from From

to To

lithology Lithology lithology
veins Lithology v veins

8. Click on Finish to complete the process.
The data tables will be added to the project tree as part of a new Drillholes object:

@& Veins tutorial - Leapfrog Geo

?;g Project Tree

¥ [ Topographies
P £ Topography
[~ Draped GIS Objects
¥ [ GIS Data, Maps and Phatos
orthophoto
¥ [ Drillhole Data
¥ ||| Drillholes
B 1 collar
1 survey
P " lithology
E‘ Composites
E‘ Planned Drillholes
E" Drillhole Correlation
E Points
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Leapfrog Geo automatically identifies and flags common drillhole data errors when drillhole
data tables are imported. There are three ways Leapfrog Geo marks tables that contain conflicts
Or errors:

« Tables containing errors are marked with a red X (¥)). These errors must be fixed before the
affected drillholes can be used for processing.

« Numeric data columns with non-numeric values are marked with a red X (), which means
that the rules that are used to handle non-numeric and negative values need to be reviewed.
If a drillhole has intervals that contain non-numeric and negative values, the drillhole cannot
be used for further processing until the rules are verified.

« Tables containing warnings are marked with a yellow exclamation mark (-). Affected
drillholes can be used for further processing, but the information in the warning can indicate
that the data requires further attention. For example, if a warning indicates there is data
missing for a drillhole defined in the collar table, it may be that a drillhole has been
duplicated or that not all required data files have been loaded. Warnings are listed along
with table errors in the Database Errors window.

Until errors are corrected, the rows that contain those errors are excluded for all processing that
usesthe table, including viewing in the scene. For example, if the ID for a collar position
contains an invalid coordinate, that collar will not be displayed in the scene as its location is not
known. Likewise, any processing will ignore data associated with this drillhole.

Itis worth correcting errors as soon as possible, as correcting them later can result in significant
recomputation time.

For this tutorial, there is only a warning for the survey table that we will not correct.

Analysing the Data

Once Leapfrog Geo hasimported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button (¥) to clear any objects from the scene window.

2. Display the data by dragging the Drillholes object into the scene:

& Veins tutorial - Leapfrog Geo

bl EEPHJJECH. [P Scene

e Project Tree &, QP e w \
¥ [ Topographies
B £ Topography
[ Draped GIS Objects
¥ [ GIS Data, Maps and Photos
g orthophoto
V [ Drillhole Data

¥ || Drillholes
B ™ collar \
53] survey
P "1 lithelogy \ _
E Compaosites llxi I
[F) Planned Drillholes

E‘ Drillhole Correlation
E‘ Points

3. Zoomin to get a better view of the data.
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Both the lithology table and the collar table are displayed and an entry for each appearsin the
shape list:

ial - Leapfrog Geo

> | B8 Projects ‘ [ Scene

g Project Tree y B f ook w %
¥ [ Topographies
P &4 Topography
[ Draped GIS Objects
v E‘ GIS Data, Maps and Photos
orthophoto
¥ [ Drillhole Data

¥ ||| Drillholes
P " collar \
7 survey T
P 1 lithology \ _
[ Composites ,ﬁ I
[F=) Planned Drillholes

E‘ Drillhole Correlation

E‘ Points

MNorth ()

H
=l OPGFO34
FRO ) ANk
¥l g H ®AYDXE

RMQHT Ire : s §INOKE

BUZHY ] okz| |
! T
b

+5359000
——
=
I
=

T

5357500
b
z
72000
1472200
o
1472400
ra
4
2
+1472600
Sh+1472800
S
2473000
H
e
T+
=
2
@
"
5
2
E]

<
o w-200%
@ " lithology 3 [fE lithology - || Edit Colours | - ) fis & I
@ ] collar 3¢ (& Flat col...- | [ ———— | B

The colours used to display the drillhole data will be different from those shown in these
images as colours are assigned randomly when data is imported.

Changing how the drillholes are displayed can help in analysing the data and making modelling
decisions.

Drillholes can be displayed as lines or as cylinders, which is controlled using the Make lines
solid button (¥) button.

4. Click the Make lines solid button (%) to display the drillholes as cylinders:

= ooy % o LY =) .
® O collar ® I:l =" % Mak:\ines solid :dmode: From Scene T.
Query filter: 'Elter v |
Line width: :
| Format Display Text
B E Full Acceleration 100+ FPS  §bZ-Scale 1.0
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The width of the cylinders can be changed in the shape properties panel:

@ "~ lithology ® mhtho\ogyv” Edit Colours | ———{ | b AA E = lithology
@ el (@ Fio col.. | ) ———( ) :
N X & rco CUUNA | siemose [fomsee [+
Query filter: | No Fiter v

Line radius: 6.00 ::\

Format Display Text |

L Full Acceleration 60FPS  F7-Scale 1.0

5. Click the Show legend button (F)) for the table:
X .EE“F;;nje_:rs [ Scene View |

Flu-WNE (RSB

lithology &3
Cover
.SchlstA
FOXa .SchlstB
AYDXE Vein A
MO .
.Veln B
Vein C
Vein D
o
=1
0
@
&
i Plunge +20 e
i Azimuth 030 S
20 © 750
R -
- o

<@ " lithology 3¢ (B, lithology~|

@ ] collar b4

6. In the shape list, click the (¥) button to remove the collar table from the scene.

7. To get a betteridea of how the layers are organised, click the Edit Colours button for the
lithology table:

P 38 [/ lithology - |[ Edit Colours | et ]l s 8

" lithology

Slice mode: From Scene >

Query filter | No Filter . » |

8. Click the visibility button (®) for each of the vein lithologies to hide them in the scene:

¥ | BB Projects sﬁcene\t’\ewi
F - WA F QN &S
& Legend for lithology lithology =
Cover
Code Colour ____y .SchlstA
@ [Cover [ 1] [ schist &
® ||Schist A ]
@® ||Schist B . L]
Vein A -
Vein B -
WVein C I:l
Vein D =
e
Plunge +20
T (T Azimuth 030
[ ]
| & concel || Sox | 250 375 9500
= 2 = s =
@ ~Jlithology 88 [ ithology - ][ Edit Colours | ———" | b s 8 B | ™ iithology
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To select multiple lithologies, use the Shift or Ctrl keys while clicking. You can then change the
visibility of all selected lithologies by clicking one of the visibility (®) buttons.

9. Click OK to close the Legend window.
Note that the legend is updated to reflect only the visible lithologies.

Hiding lithologies in this way only changes how the data is displayed in the scene. Another
way of limiting the data displayed is to use a query filter, which can later be used in selecting
a subset of data for further processing.

We can see that the lithology layers, from oldest to youngest, are:

« Schist B (pink)

o Schist A (blue)

o Cover(green)

When building a geological model, it is best to define the contact surfaces by starting with the
oldest and working up. For this project, Schist B and Schist A are deposits and are the oldest
lithologies. They are then cross-cut by the vein lithologies, and the deposits and veins are
eroded by Cover. Therefore, the best way to build this model is to:

o Model the deposits, Schist B and Schist A.
+« Model the veins.

« Model the erosion.

Creating the First Geological Model

To create the first geological model:
1. Right-click on the Geological Models folder and select New Geological Model.
2. In the window that appears, change the following settings:

« Setthe Surface resolution to 50.

o Fromthe Enclose Object dropdown, select the lithology table.
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¥ | B8 Projects | [ Scene View

&Lookvwkﬂ RN B

& New Geological Model lithology®
Cover
enes s Schist A
Base lithology column: [ lithology v Schist B
‘ .Ueln A
ra— . . Vein B
Surface resolution: _SD.D s d Adaptive [| _ Vein C
Model Extents Vein D
Minimum Maximum =
X (Fast):  [1471200.0 2 [14733000 ol E
" 3 £ L
| d
¥ (North): |5357300.0 2 |s2592000 = q 5
Z (Elevi:  |-3000 2 |260.0 =
Plunge +20 @
Enclose Object « Azimuth 030
0 500 1000 1500 2000
Name: |Gm |
b AAE
I Help 3 cancel <ok

All settings can be changed after the model is created, except for the Base lithology
column. For the Surface resolution, Leapfrog Geo sets a value based on the data available,
but you can set a higher (coarser) value when you first create the model in order to reduce
processing time. Lower resolution values provide more detail, but surfaces will take longer to
process.

3. Click OK to create the geological model.

The new geological model will be created in the Geological Models folder:

V¥ [ Geclegical Medels
v (@ cm
P @ Boundary
&3 Fault System
P = Lithalogies
@ surface Chrenclogy
P [ Output Volumes

The Boundary object defines the limits of the geological model. When the model is first
created, thisis the rectangular model extents. If a topography has been defined, it is
automatically used as the upper boundary.

The Fault System object defines faults and their interactions in the model.

The Lithologies object describes all the lithological units to be modelled in the geological
model and the colours that are used to display them on the screen. Itis generated
automatically from all the lithologies identified in drillhole data selected when the model is
created. If no column was selected, you will need to define the lithologies manually before
you start modelling the lithology layers.

The Surface Chronology object describes the contact surfaces in the model, organised in
chronological order, from youngest to oldest. These surfaces and their chronology
determine how the volume inside the model extents is divided into lithological units. When
the modelis first created, the Surface Chronology is empty, but it will eventually hold all
contact surfaces and inputs to them.

The Output Volumes folder contains all the volumes generated in building the geological
model in chronological order, from youngest to oldest. When the model is first created, the
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Surface Chronology is empty and so there is only a single output volume that fills the
model’s extents, called “"Unknown”.

4. Double-click on the Lithologies object.

The Geological Model window opens with the Lithologies tab displayed. The lithologies for the
new geological model include those from the drillhole data and the lithology “Unknown”:

& Geological Model - GM

General Boundary Fault System | Lithologies | Chronology
Code Colour
Unknown l:l
Cover l:l
Schist & B
Schist B B
Vein & il
VeinB =
Vein € B
VeinD B

o= Add
Eaer Bomee | [ o |

5. Click Cancel to dismiss the Lithologies window.
6. Clear the scene.
7. Display the geological model by right-clicking on it and selecting View Output Volumes.

¥ | BB Projects | G Scene View

Flu- BN E[HN\ &7

Morth ()

East (X)

Plunge +20 @
Azimuth 030

1] 500 1000 1500

= B Giiown 38 [& Litholo...- | | b | & unknown

At this point, the model is a single volume of lithology “Unknown”. In order to divide this
“Unknown” volume into volumes that represent known lithologies, we need to define the
model's internal structure. This involves:

« Generating contact surfaces that correspond to the boundaries between lithological units

« Refining the contact surfaces
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« Arranging themin chronological order

« Using the surfacesand the chronological order to divide the geological model into units.

There are different types of contact surfaces that interact with other surfaces and volumes in
different ways:

« Deposit contact surfaces do not cut older volumes. A volume defined by a deposit contact
surface will, therefore, appear conformably on top of older volumes.

o Erosion contact surfaces cut other contact surfaces on the older side of the erosion contact
surface.

« Intrusion contact surfaces remove existing lithologies and replace them with the intrusive
lithology on the younger side of the contact surface. Often, the older side of an intrusion
contact surfaceis labelled “Unknown” as typically intrusions displace multiple older
lithologies.

« Vein contact surfaces remove existing lithologies and replace them with the vein lithology
within the boundaries defined by hangingwall and footwall surfaces and pointsand a
reference surface.

Itis not always necessary to model geological formations according to their corresponding
contact surface type. For example, it might make sense to model basement granite as a deposit
rather than asan intrusion when it forms the lowest layer in a geological model: if there are no
older layers for an intrusion-type contact surface to remove and it isapparent from the drillhole
data that the lithology simply fills the lowermost parts of the model, then it makes sense to
model it as a deposit.

See the topic in the Leapfrog Geo online help for more information on the
different types of contact surface and how they interact.

For the geological model in this tutorial, however, we can model each lithology according to
the corresponding contact surface type.

Modelling the Deposit Contact Surfaces
In . we saw that the oldest lithologies in the drillhole data are two deposits:

e SchistB
e Schist A

The first contact surface we will model is the oldest (lowest), Schist B, and we will model it asa
deposit.
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1. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology:

¥ [ Geclogical Models
¥ (7 6m
P @ Boundary
&3 Fault System
P 5 Lithologies
‘\7‘ Surface Chronology

Martk

P [ Output Volumes Open ‘) poSomment
[ Numeric Maodels {# New Deposit » | 8 From Base Lithology.. l}
E‘ Combined Models j_‘/ Mew Erosion 4 v‘ﬁ From Other Contacts...
[ Block Models M Mew |ntrusion » | "2, Erom Palyline... F
[ Saved Scenes and Movies | (% New Vein 4 From GIS Vector Data... r
E‘ Cross Sections and Contou| (8 New Structural Surface a From Structural Data...
[ Colour Gradients 5% New Vein System £ From Points...
m MNotes ¥ New Stratigraphy X From Offset Surface...
View Al & From Surface...
4 Prioritise
EJJ Properties...

2. In the window that appears, select “Schist B" from the Select primary lithology dropdown
list:

& MNew Contact Points

Litholegy | Com positing

Contact in Column 'lithology’ on Table "lithology®
Query filter: Inherit from GM
Select primary lithology
":l Cover v
l:l Cover
I schist &
[ schistB I
- Vein A
- Vein B
l:l Vein C
l:l Vein D

|| veinC(O)
[ veinD (0)

Treat unspecified intervals as
® Ignored O Primary ) Contacting

Reference Plane

Horizontal plane

MName: |Cover contacts I

;_; Help ‘%Qancel -QBQK

We saw in that Schist B contacts Schist A, so we want to build a surface that
represents the contacts between Schist B and Schist A. Therefore, we will keep Schist Ain the
Contacting/Avoiding lithologies list. The veins, however, are younger lithologies than Schist B
and Schist A, so we want to ignore them.
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3. Drag each of the vein lithologies to the Ignored lithologies list:
& New Contact Points X

Lithology | Compositing

Contact in Column "lithology’ on Table 'lithology’
Query filter: Inherit from GM
Select primary lithology

[ schist & -

®) Use contacts above O Use contacts below

Contacting/Avoided lithologies: Ignored lithologies:

[ Schist A (80) [ Cover (o)

B Vein A (8)

[ vein B () I:- Vei W:l @
[ ] veincig)

[ veinD (3)

Treat unspecified intervals as
® Ignored (@] Primary (@] Contacting
Reference Plane

Horizontal plane

Mame: [S(h\StB(DHtE[tS |

4. Click OK.
The new contact surface will appear in the project tree under the Surface Chronology.
5. Expand the contact surface to view the objects used to create it:

¥ [ Geclogical Models
¥ (7 6m
[ =] Boundary
B3 Fault System
> :—El Lithologies
¥ (@ Surface Chronclogy
W [ Schist B - Schist A contacts [inactive]
v ‘ﬁ Schist B - Schist A contacts
W [ Schist B - Schist A contacts
[y lithology
[ E‘ Output Volumes

Note that the contact surface is marked as inactive. When you create a contact surface, it
appearsin the project tree under the Surface Chronology object, but itis not enabled and,
therefore, does not affect the geological model volumes. This means you can work on the
surface without having to reprocess the model whenever you make a change to the surface.
In Leapfrog Geo, you can easily define, enable and remove contact surfaces froma model,
and you can experiment with modelling lithologies using different techniques in order to
arrive at a geologically reasonable model.

6. Clear the scene.

7. Add the new contact surface (#¥) to the scene, together with the points () and segments (")
used to create it.

8. Display the legend (=) for the segments.
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The segments (™) show how the lithologies in the drillhole data have been handled in order to
create the contact surface:

¥ | BB Projects | G Scene View

Fl-WNE [N ®S

Schist - H
Schist A co...

. Avoided
. Ignored
. Primary

5 .
% t
) 5 o b o o ° 4 = °
; 5.2 8 o 2 £ 2 3 & 5 %
L/,at“' I I o Il I Iz Il I I k)
. o [ o I [ - - ~ - - =
] & 3 3 k) k! & 5 & 3 T Plunge +0%
t + + + + + + + + + + Azimuth 399
0 125 Z50 375 500
@ HGM: Sutects 3§ (& Flat col...- ||| 1\ Schist B - Schist A contacts
@ [ GM..act Litholo... v Iy [Fromscene |
= e ® (& Litholo |:H:| b b ® Slice mode: From Scene v
@ [\ Sch...cts 38 [~ Schist ... +|[ Edit Colours | R oy = e
Query filter: No Filter v

The underside of the contact surface is Schist B (pink) and the topside is Schist A (blue).
9. Double-click on the Surface Chronology.

The Geological Model window will be opened with the Chronology tab displayed:
10. Tick the box to enable the contact surface:

& Geological Model - GM

General Boundary Fault System  Lithologies | Chronolegy

Contact surface chronology

Contact surface

{# Schist B - Schist A contacts

“
Younger
Older
3
Background lithelegy: I:lUnknown v

R

11. Click OK.

12. Once the changes have been processed, drag the Output Volumes folder into the scene.
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The Schist B output volume (&) has filled the space indicated as the primary lithology:

X 88 Projects | [ Scene View

Flu- WY & [B\ &7

SchistB - B
Schist A co...

. Avoided
. Ignored
. Primary

North ()

East ()

Plunge +20 @
Azimuth 030

[1] 500 1000 1500

® G5 tacs (@@ Fit ol I —— & schiste
& GM..st A w ‘L\tho\u ') Slice mode: lFrDm Scene hd
SRR S oo [ e LD | v,
@ @ GM..acts 3 |& Litholo... l:l = b x
@ s Schoets 3 Edit Colours | = N

The lithology on the younger side of the contact surface has been used to fill the remainder of
the model space.

When you right-click on the geological model in the project tree, there are three ways to view it:

« View Object adds the geological model to the shape list as a single object. You can also
display the model in thisway by dragging it into the scene.

o View Output Volumes adds the volumes in the Output Volumes folder to the scene. You

can also display the model in this way by dragging the Output Volumes folder into the
scene.

« View Surface Chronology adds the model's surfaces to the scene.

Modelling the Veins

Veins can be modelled as individual contact surfaces or as a vein system. When the drillhole
data has the veins sorted into individual lithologies, it is best to model veins one-by-one.

1. Clearthe scene.
2. Right-click on the Surface Chronology object and select New Vein > From Base Lithology.
3. Inthe window that appears, select “Vein A"

& New Vein

Vein in column ‘lithology” on table 'lithology®

Query filter: Inherit from GM

Include poi

Nome: [Cover | < i

s [ vein A

;—”‘ Helg - Vein B
7|:| Vein C —
I:l Vein D
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4, Click OK.
The new vein surface will appear in the project tree under the Surface Chronology.

5. Expand the vein to view the objects used to create it:

¥ [ Geological Models
¥ (& Gm
P @ Boundary
&3 Fault System
b E‘ Lithologies
v @ Surface Chronclogy
V% Vein A [inactive]
B> veinA Hangingwall
P[> Vein A Footwall
B s Vein A
B A Vein A Pinch Quts [inactiv
P 27 Vein A Reference Surface
';' Vein A Boundary [empty]
B (% Schist B - Schist A contacts
B [ Output Volumes

The vein is made up of:

« Hangingwall and footwall surfaces (#), which, when expanded, show the hangingwall and
footwall data objects used to create the surfaces.

« Vein segments and pinch out segments (™) extracted from drillhole data. These are only
included when a vein is created from lithology contacts and are disabled when the vein is
first created.

« Areference surface (#°) calculated as the best fit surface using the hangingwall and footwall
surfaces.

« Aboundary object (¥*), which is empty when the vein is first created.

6. Drag the vein into the scene and make it partly transparent.

7. Expand the hangingwall and footwall surfaces surfaces (#) and add their points objects (%)
to the scene.

The scene will appear similar to this:

¥ | BS Projects | [P Scene View

Fl- W\ & (BN #S

Morth ()

+1473200
East ()

Plunge +20 @
Azimuth 030

500 750 1000

< e Veiwall FE [TJHW / Fw- || Edit Colours | — " Bl | &, Vein A Footwall
@ & Vei.wall Edit Col — :
o Verwall 38 (L] ! troour Slice mode: From Scene -
® e, 3 [@Lthoo..- | N — @ = b b
Query filter: Mo Filter v

We can see that the vein extends well beyond the Vein A hangingwall and footwall points.

8. Expand the geological model’'s Boundary object (not the vein boundary) and add the GM
Extents object to the scene.
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9. Press the D key to view the scene from above.

10. Zoom out to view the GM Extentsin relation to the vein:

* | BB Projects | @ Scene View

Flu-WNE RN ES

| MNorth ()

®+5359000

®+5358500

Looking down e

500 1000 1500 z000

=
p
47200
@
&
E
n+1472500
w+1473000

=)

|East ()

® & Velwall ¥ (£ GM Extents
@ (7 GM... 38 (& Flat col.. - || |
®®M. 3 @ Ltholo.. | I Y

Slice mode: [Frum Scene v

The problem with the shape of the vein is that it extends to the model boundary, in spite of the
hangingwall and footwall points being restricted to the centre of the model.

Vein walls can be set to pinch out where drillhole data indicates they do not occur. This s
achieved by creating ‘outside’ intervals on drillholes that do not have an interior vein segment.
These intervals are then flipped with respect to interior vein intervals, which, in effect, meansthe
footwall and hangingwall orientation has the opposite sense to the nearest interior intervals.
This forces the hangingwall and footwall surfaces to cross, thereby pinching out. These
pinchout points can be viewed in the scene and edited, if necessary.

11. Double-click on the vein (%) in the project tree.

12. In the Edit Vein window, click the Surfacing tab, then tick the box to enable the Pinch out
option:

@& Edit Vein A

Lithologies | Surfacing | Inputs

Boundary filter: | Drilling enly v
Snap to data: Inherit from GM (Off) v

Inherit resolution from GM

[] Maximurm thickness:

Minimum thickness: |0 n

I ["] Pinch out I

Name: |Vein A I

13. Click OK.
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When the changes have been processed, the revised vein will appear in the scene:

500 1000

Plunge +41
Azimuth 011

1500

o

2000

The vein now pinches out and no longer occurs where there isno Vein A in the drillhole data.

14. Create veins B, C and D in the same manner, enabling pinch outs.

15. Clear the scene, then add the veinsto it.
The scene should appear similar to this:

¥ | BB Projects | [ Scene View |

e AN AN 4

Elev (Z)

Morth ()

o
=]
T
@
wn
™
wn
T

1472600

1472400
+

+1473000

+1472800

1473200

+

Plunge +20 @
Azimuth 030
[*] 250 500 750

East (X)

B +
t//J_r——’”
oM 3RS Liholo.. - | e O b o =
S Ty e =y
N X @] ] ——i bb
o Nom. K @l | I ——) b b

4§ veinA

Slice mode: Ime Scene

Fill Slicer

At this point, we have changed the vein settings so the veins are a more realistic shape. However,

they are not yet enabled in the geological model.

16. Double-click on the Surface Chronology.
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17. Enable each vein and arrange them so they appear in the following order:

® Geological Model - GM

General Boundary Fault System L'rtlmlogis| Chronology

Contact surface chronology

Coentact surface

¥ VeinD

% VeinC

% VeinB

(% Vein A

{# Schist B - Schist A contacts

&

[SESESESES|

Younger

Older

Background lithology: [l:lUnknown | - J

Ny Ko || Soc |

18. Click OK.

19. Clear the scene.

20. Once the model has been processed, add the Output Volumes folder to the scene.
21. While holding down the Ctrl key, click on Schist A and Schist B in the shape list.

22. Drag the opacity slider to make the deposits partly transparent:

~ [ @ s

Flo-WNEF DNES

@ {8 GM: Schist A 3% [& Litholo...- I — =— Qb o F|l| (@2 shapes
@ & GM; Schist B 3 & Litholo...- | — — Ao |
S Y e [e——

lice mode: Ime Scene | - J

Fill Slicer

@ @ouvens 3¢ (@i NI —— b b ]
@ @ouvenc X @es] ] (11 b
@ @ouvend ¢ @i | ) b s 7|

To see how the veins cut the deposits:
23. Remove all the volumes except Schist B from the scene.
24. Make Schist B opaque.
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The scene should appear similar to this:

AR AN IR X

Modelling the Erosion Contact Surface

The final step in building the model is to create the last contact surface, Cover, which will be
modelled as an erosion contact surface.

1. Right-click on the Surface Chronology object and select New Erosion > From Base

Lithology.
2. In the window that appears:

« Select “Cover” from the Select primary lithology dropdown list.

¢ Clickthe Use contacts below button.
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As Coveris the uppermost lithology in the model, we need to select contacting lithologies from
the contacts below. Both Schist A and Vein A appear in the Contacting/Avoided lithologies list:

& New Contact Paints X

Lithelogy = Compositing

Contact in Column "lithology’ on Table "lithology"
Query filter: Inherit fram GM
Select primary lithology

Icover v

() Use contacts above (® Use contacts below

Contacting/Avoided lithologies:  Ignored lithologies:

[ schist A (47) [ schist B (1)

B vein A (1) B vein & (0)
[ veinCim
[ vein D i

Treat unspecified intervals as
(O] Ignored (@] Primary O Contacting

Reference Plane

Horizontal plane

MName: [Cnver contacts |

When we created the deposit contact surface, we ignored the vein lithologies because they
were younger than the deposits we were modelling. Here, however, Vein A is older than Cover
and so we will keep it in the Contacting/Avoided lithologies list.

The other lithologies, however, appear in the Ignored lithologies list because there are no
contacts between those lithologies and Cover. This might not always be the case. For example,
when drillhole data is appended, there could be contacts between Cover and these other
lithologies. Because Cover is younger than all other lithologies, we need to move the lithologies
in the Ignored lithologies list into the Contacting/Avoided lithologies list.

3. Drag each lithology from the Ignored lithologies list into the Contacting/Avoided
lithologies list.

4. Click OK.

Once a contact surface has been created, itisa good idea to view it in the scene to ensureitisas
expected.

5. Clear the scene.
6. Add the new contact surface to the scene.
7. Add the lithology table to the scene.
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The scene should appear similar to this:
X .Eg;;nje_d‘s [ Scene View |

Fluw-WNE [N\ S

lithologyE3

—— Cover

. Schist A
. Schist B

+5359000

Plunge +20 e
Azimuth 030

250 500 750

=
= =1
=] o)

+5358500

000
473200

El | ™ iithology

Slice mode: From Scene - |

-5
< (7 GM: Cover contacts

8. Double-click on the Surface Chronology.

Because we've defined the contact surfaces from oldest to youngest, the Cover contact surface
appearsin the Surface Chronology as the youngest lithology, so there isno need to change the
chronology.

9. Enable the erosion contact surface.

10. Click OK.

11. Clear the scene.

12. Once the changes have been processed, add the model to the scene.
The erosion contact surface has cut away the deposits and veins:

gv Look = w K ﬂ @\\ ﬂ f

Plunge +20 e
Azimuth 030

0 500 1000 1500
@ @ GM: Cover ® [& Ltholo.- | —— ) b 8 SchistB
> @on (@ .. ——— :

& GM: Schist A ¢ & Litholo. Y e |
el Litholo.. = | " = ~
| EE— - I W S| i
@ & GM: Vein A 3¢ [& Litholo... - | | b =
@ @ GM: Vein B ¢ |&Litholo...~ _l =
@ @ GM: Vein C ® @thoo. <[ | ——1p =|
® @ GM: Vein D ® [& Ltholo.. - | ——( ) b

B Full Acceleration 100+ FPS  § Z-Scale 1.0

13. Press the D key to view the scene from above.
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14. Click the Show slicer button (™).
15. Click on the slicer in the shape list.
16. In the shape properties panel, click on the Set to button and select Elevation (Z) Axis:

— | %, Slicer
® @GM.ver 3 [@Litholo.. - | ———( v ] b |
a@cM.ta ¥ [@Ltholo..- | I —— ) b |l ik 8| | Location | 3tto ¥
a@cM.t8 R [@ oo | I —— ) b =] stepsiz= (1000 [2] | 3 0 Eest 00 s
e@ov.a 3 [@ o | I —— ) b ||| o oo | Sletthas
®>@om.8 ¥ [@Lthoo..- | N —— ) b || e o] - MRS i
— L8 i Top
@M. ¢ K [@Ltholo.~|[ | =——=1 b I
-~ an @ | B | =T
LN @Fuliﬁ\:ceiemﬁon 46FPS b Z-Scale 1.0

With the slicer tool selected, hold the Ctrl key and the right mouse button to change the
position of the slicer in the scene:

: @ ]|

e N Y Y

Looking down °

1000 1500
Plan section +5.32
®@ot.ver R [dLitholo.. | [N ——("] b ; e
®@cMiA 3 [@Ltholo.- | ——— ) b < || Sticeia: (3000 ] E: Location | St ~ |
@18 3 [ Livoo- | N —— ) b ==|] sepsee [0 [ (2] x

@A 3 [@ o | I ——C b

@B 3 [@ o, | N ) b b T

c@on.C R |[@unoes| (il b
P [y pmm—

~

Dip: 00 3w [s3sezs000 |3
Dipsz: |00 5|z 5324675324675 )3

1'% L_ij Full Acceleration 52FPS @ Z-Scale 1.0

Using a Vein System

There are two ways of modelling veins in Leapfrog Geo:

« Model individual veins. Thisis the approach we used for the first geological model. The veins
interact with one another and with other lithologies as defined by the Surface Chronology.

» Model a vein system. The vein system represents a single lithology within the geological
model. How the veins interact with one another is determined by settings in the vein system,
and how the vein system as a whole interacts with other lithologies is determined by the
Surface Chronology.
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The lithology table in the drillhole data imported in has two
columns:

o The lithology” column contains the two deposits (Schist A and Schist B), the erosion and four
vein lithologies.

« The"veins’ column contains the two deposits, the erosion and a single “Veins” lithology that
represents all the veins.

In order to model a vein system, we will create a new geological model using this “veins” column
and model the veins as part of the vein system using the data in the “lithology” column.

To start:

1. Clearthe scene.

2. Right-click on the Geological Models folder and select New Geological Model.
3. Inthe window that appears, change the following settings:

« Selectthe "veins’ column for the Base lithology column.
« Setthe Surface resolution to 50.
o Fromthe Enclose Object dropdown, select the lithology table.

« Name the model "Vein system GM”,

@& Mew Geological Model

General

Base lithclogy column: |38y veins -

Surface resolution: |50.0 = [ Adaptive

Model Extents
Minimurm Maximum

X (East): [1471800.0 = !:14.73300.0

Y (Morth): [5357300.0 = | 5358200.0

Z (Elev): [-300.0 = !:ZED.D

Enclose Object «

Name: |Vein system GMl

i Help & cancel <ok

4. Click OKto create the geological model.

Creating the Vein System

For this model, we won't model the deposit and erosion contact surfaces, but will only model
the vein system.

1. Right-click on the Surface Chronology and select New Vein System.
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2. In the window that appears, select "Veins" for the Vein lithology:

@& New Vein System

Select lithology

Vein lithology: l:lUnlmnwn -

Outside lithology: :l Unknawn
Cover

[ Schist A
Name: | Unknown Ve
= ‘—— Il 5chist B
- Veins
;_;Hslp %Ean(sl L\\E -Qﬂgl(

Because veins usually contact multiple lithologies, leave the Outside lithology set to
“Unknown”.

3. Click OK.

The new vein system will appear under the Surface Chronology. It isempty and inactive.

Creating the Veins

Next, we will define each vein using the lithology data from the “lithology” column.
1. Right-click on the vein system and select New Vein > From Other Contacts.

2. In the window that appears, select the “lithology” column.

3. Click OK.

4. In the New Vein window, select “Vein A", then click OK.

The new vein will be added to the project tree as part of the vein system.

5. Expand the vein system and add the new vein to the scene.

¥ | B8 Projects | [l Scene View

AR AN NN

Worth (v)

+1473000
+1473Z00
East (X)

+1472400

Plunge +20 @
Azimuth 030

250 500 750 1000

® (8 veininA_ $§ [&Fietcol.- | I b 3 Vein A

We need to enable pinch-outs for the vein in order to achieve a realistic shape.

6. Double-click on the vein () in the project tree.
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7. Click on the Surfacing tab and enable the Pinch out option:

& EditVeina X

Interactions | Surfacing | Inputs

Boundary filter: | All data -
Snap to data: Inherit from GM (Off) L4

Inherit resolution from GM

[] Magimum thickness:

Minimum thickness: |0 <

I [] Pinch out I

Mame: |Vein A J

8. Click OK.

When the changes have been processed, the revised vein will appear in the scene.
9. Create veins B, C and D in the same manner, enabling pinch outs.

10. Clear the scene, then add the vein system to it.

The vein system appears in the shape list, but there is nothing in the scene as we need to enable
the veinsin the vein system and set their interactions.

Setting the Vein Interactions

We can determine how the veinsinteract by displaying them in the scene.
1. Clearthe scene, then add each of the veinsto it.

2. Pressthe D key to view the scene from above.

3. Click on the second vein down, as shown:

¥ | BB Projects | [ Scene View

Pl W\ # [N &7

+5358400

K,_r .
«¥ Vein system GM: Vein A

Location 1472772.0465,
5358323.2317, 120.8377

Face dip 76,5202

Thickness 579

Volume 1,074,500 -

Area 498,130 3 3 2 ] ] Looking down e
Parts 1 3 g 8 2 ] ¥

[ 5 5 or 125 250 375 500

“I"Add Comments 7 hd s T - ]
<® (i Vein...in A 4 @F\at cUIH.vllgml o m :v;(} Vein A
= ey B &fetcol..- l—‘ b Slice mode: lFrom Scene v
@ (o Vein.inC 3§ [&Flat col..- | [ NN b b i
® (4 Vein..inD 3§ [& Flat col...- | [N Py S
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Thisis Vein A, which will we consider the central vein. In order to determine the interactions
between Vein A and the other veins, we need to know which side of Vein A is the hangingwall
and which side is the footwall. We can do this by adding Vein A's hangingwall and footwall
points to the scene.

4. Expand Vein A in the project tree to view the points that make up the hangingwall and
footwall surfaces:

¥ [ vein system GM
P @ Boundary
&3 Fault System
B E‘ Lithologies
v '\? Surface Chrenclogy
W % Veins Vein System [inactive][=mpty]
¥ (% Vein A [inactive]
V W VeinA
¥ [> Vein A Hangingwall
P & Vein A Hangingwall
P &% Vein A Pinch Outs Hangingwall
¥ [> Vein A Footwall
P %=, Vein A Footwall
B - Vein A Pinch Outs Footwall
B s vein A
B (i Vein A Pinch Outs
P 7 Vein A Reference Surface
<7 Vein A Boundary [empty]

5. Add the hangingwall and footwall points (+) to the scene.
6. Click the Show legend button (&) for the footwall points:

¥ | BB Projects [ Scene View

Flu-WN# [N &7

HW /Fw B

. Excluded
. Foot Wall
. Hanging Wall

oo

oo
oo
oo
Looking down e
200 300
oo
@ ﬁ@.VemA Ve..Footwall 8 [TIHW/ Fw-~|[ Edit Colours | \ EE] | &, Vein A Footwall
@ &, Vein A: Ve..ngingwall  §§ m Edlt Colours s [me Scene i
. 1 5ps..: Vein A ® &F\at col... l:l bbb
Z filter: Neo Filt
ys...: Vein B 8 (&Fiatcol..~| l:l B ey e s ¥
4 sys...: Vein C ¥ |&Fiatcol..~ :l bbb Foint size: 3 -
<® (4 Vein sys...: Vein D ® (& Flat col...- | b Format Display Text
8 55/ Full Acceleration 67FPS £ Z-Scale 1.0

The other veins interact with Vein A as follows:
« VeinsB and D terminate against Vein A on Vein A's hangingwall side.
« Vein C terminates against Vein A on Vein A's footwall side.

Now we can set the interactions for the vein system.

7. Double-click on the vein systemin the project tree.
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& Edit Vein System

Lithology Vein System

Vein priority
[ Veins
Vein A

Vein B
Vein C

Ueim 1

googd

Name: |Veins Vein System

I
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The veins appear in the Vein priority list in the order in which they were defined. Because Vein A

is already at the top of the list, we don't need to change the order.

Vein Ais the highest priority vein in the list, and so no interactions can be set for it.
9. Click on Vein B and click the Add button.

Only veins that are higher in priority than the selected vein will appear in the Vein list, so the
correct vein has been selected. The Side is also correct:

& Edit Vein System

Lithelogy | Vein System
Vein priority

[] Veins
[ VeinA

[1 VeinB

[l VeinC
Cl ein n
Interactions of Vein B
Interaction Type  Vein Side

Terminates against Vein A Hanging wall

s Add | | == Remove

B s
Higher

Lower

E B

MName: lVainsVein System

gﬂe\p % Cancel

10. Clickon Vein C, then on the Add button.

© 2017 ARANZ Geo Limited



50 | Leapfrog Geo Tutorials

11. Select "Foot wall” for the Side:

&

Lithology Vein System |

Edit Vein System

Vein priority

[0 |Veins —I}
L vema . éigher
i =
R IE

Interactions of Vein C

Name: [Vems\fem System

Side

Terminates against Vein A v Hanging wall

Interaction Type  Vein

Hanging wall

Foot wall E; |
. ‘
s Add | | == Remove | ‘

]

Hiuep |

12. Click on Vein D, then on the Add button.
Again, the default interaction is correct.
13. Tick the box for each vein to enable them in the vein system, then click OK.

14. Clear the scene.

15. Add the vein system to the scene:
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The vein system appearsin the scene asa single lithology.
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If all four veins do not appear in the scene, it is likely that the interactions have not been set
correctly. If thisis the case, the affected vein will appear in the project tree as empty:

¥ [ vein system GM
P @ Boundary
3 Fault System
[ 3 :—El Lithologies
WV (@ Surface Chronelogy
W % Veins Vein System [inactive]
B {4 Vein A
B (% VeinB
P (% Vein C [empt

2 VeinD
B [ Output Volumes

Double-click on the vein or the vein system to correct the interaction. Here, double-clicking

on the vein opens the Edit Vein wi

ndow:

& EditVeinC

i

Interactions | Surfacing  Inputs

Interactions of Vein C

Interaction Type  Vein Side

Terminates against Vein 4 | » | Hanging wall
Hanging wall
Foot wall I,\\)

+ Add | | == Remove

v

ame: !:Vein C

L Help

Enabling the Vein System in the Model

Although the vein system is now complete, we still need to enable it in the model.

o N O O AN DN -

. Clear the scene.

. Add the model to the scene.

. Press the D key to view the scene f
. Click the Show slicer button (™).

. Click on the slicer in the shape list.

. Double-click on the Surface Chronology.

. Enable the vein system and click OK.

rom above.
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With the slicer tool selected, hold the Ctrl key and the right mouse button to change the
position of the slicer in the scene:

¥ | B2 Projects | G Scene View

F - WhNEe NNES

Looking down e

1] 250
Plan section —20.00

500 750
NSl 3 OB CBEME S D %, Slicer
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Reset

Stepsize: 1000 |- X |1472550.00 |2
Dip: Vi |5358250.00 =
Z: |-20.00 =

El Full Acceleration 100+ FPS  §bZ-Scale 1.0

3

4

o
-

Dip az.:

»

Because we haven't defined the lithologies outside the vein system, lithology “Unknown” is
used. Compare the vein system with the individual veins modelled as part of the GM model.
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Tutorial 3: Modelling a Syncline in a Series of
Deposits

In this tutorial, we will use drillhole data to build a model of a syncline in a banded iron
formation. Whereasin we modelled the contact surfaces
individually, for this tutorial, we will model a series of deposits using a stratigraphic sequence.

Data for this tutorial can be found in the Syncline folder.

Setting Up the Project

To start:
1. Launch Leapfrog Geo.
2. In the Projects tab, click New Project.

3. Enterthe name "Syncline tutorial” for the new project and click Browse to select a folder
where the project will be saved.

4. Click OKto create the project.

The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing a Photo and Setting the Clipping Boundary
First, we will import an aerial photo and use it to set the clipping boundary. Thefileis called
“photo.tif".

1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called photo.tif, then click Open.

3. Click Import to import the photo.

4. Add the photo to the scene and press the D key to view it from above.

5. Right-click on the Topographies folder and select Set Clipping Boundary.
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6. From the Enclose Object list, select <Everything>:

>~ | BB Proje‘:‘t;" EiSceneViewi .
95’ Look ¥ w\ & |_m|*\\ & é’?

Morth () f

@ Set Clipping Bounda x
Clipping Boundary
Minimum Maximum
X (East): 053200 7] [1024000
¥ (North): (1976000 |3| [2032000 3 < =p
| Enclose Object v |
<Everything>[}
Her | Hcone g
a 1250 2500 3750 5000
e % : ! S

7. Click OK.

Importing the Drillhole Data

Data for this part of the tutorial can be found in the Syncline > Drillholes folder. There are three
files:

« collar.csv contains the collar definitions.
e survey.csv contains information that describes the deviation of each drillhole.
« geology.csv contains the interval definitions that describes the lithology.

1. Right-click on the Drillhole Data folder and select Import Drillholes.
The Import Drillhole Data window will be displayed.

2. For Collar, click on the Browse button to locate the tutorial file collar.csv.
3. Click on the file, then click Open.

All files have been added to the Input Files list.

4. Click on Import to start the process of importing data.

5. Leapfrog Geo correctly maps the data in the collar and survey files, so click Next for each
one.

6. Forthe geology table, click on Finish to complete the process.
The data tables will be added to the project tree.
Now that we have imported the drillhole data, we can use it to create the topography.
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Creating the Topography

In , we created the topography from an elevation grid. For this
tutorial, we have no topography data, so we will use the collar pointsin the drillhole data.

A key advantage of defining a topography is that it provides consistent elevation data for
objects imported to and created in the project. The quality of elevation information can be
poor compared to X- and Y-coordinates, which can create problems when using objects to
build a model. A topography can be created from the most reliable elevation data, and other
objects can have elevation set from this topography.

1. Right-click on the Topographies folder and select New Topography > From Points.

All points object available in the project will be listed, which, in this case, is only the imported
collar points:

& Select Points To Add

v il

1 collar

i Help 8 cancel ok

2. Click OK.

3. In the New Topography window, click OK to accept the default name and create the
topography.

Analysing the Data

Once Leapfrog Geo hasimported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button (¥) to clear any objects from the scene window.

2. Add the geology table to the scene.

3. Click the Make lines solid button (%) to display the drillholes as cylinders.

4. Click the Show legend button (F)) for the table.

5. Zoomin to get a better view of the data.
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The scene should appear similar to this:
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The lowest layer in the model is Granite, which we can model as a deposit, and the highest layer
is Gravel. Although we could model the deposit contact surfaces one-by-one, the layers are
roughly continuous, which lends itself to modelling using a stratigraphic sequence. Therefore,
we will model the layers by defining a stratigraphic sequence that has Granite as the lowest
layer and Gravel as the highest.

Creating the Geological Model

To create the geological model:
1. Right-click on the Geological Models folder and select New Geological Model.

2. In the window that appears, change the following settings:
» Setthe Surface resolution to 50.
o Fromthe Enclose Object dropdown, select the geology table.

3. Click OK to create the geological model.
The new geological model will be created in the Geological Models folder.

Defining a Stratigraphic Sequence

To create the stratigraphic sequence:
1. Right-click on the model’s Surface Chronology and select New Stratigraphy.
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2. In the window that appears, select Gravel for the Lithology Above and Granite for the

Lithology Below:

Defining a Stratigraphic Sequence | 57

& New Stratigraphic Sequence

Chronalogy | Surfacing

Lithology Above: - Gravel v

Stratigraphic Lithologies:

Add Lithologies

Lithology Below: |0 Granite -
Bottom Contact Type: |Deposit v

Surfaces gvoid drillhole segments

Name: | Stratigraphic Sequence ]

3_;;ﬂe\p %Qan:el @QK

3. Click the Add Lithologies button.
4. Click the Lithology box to select all the lithologies:

5. Click OK.
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The lithologies have been added to the Stratigraphic Lithologies list:

@ New Stratigraphic Sequence

Chronology | Surfacing
Lithology Abave: [ Gravel [+]
Stratigraphic Lithologies:
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[ Middle Shale ®
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6. Click OK.
7. Clear the scene.
8. When Leapfrog Geo has finished generating the stratigraphy, add it to the scene:
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9. Expand the stratigraphic sequence in the project tree:

¥ [ Geological Models =
¥ (@ am
P @ Boundary
&3 Fault System
[ Lithelogies
¥ @ Surface Chronelogy
v 3 Stratigraphic Sequence [inactive]

P i Upper Shale - Gravel Contacts
P & Upper Banded Iron Formation - Upper Shale Contacts
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P & Upper Carbonate - Middle Shale Contacts
P @ Lower Banded Iron Formation - Upper Carbonate Contacts
[ # Lower Shale - Lower Banded Iron Formation Contacts
P @ Upper Basalt - Lower Shale Contacts
P & Lower Carbonate - Upper Basalt Contacts
P Middle Basalt - Lower Carbonate Contacts
P # Sandstone - Middle Basalt Contacts
P & Lower Basalt - Sandstone Contacts
[ # Granite - Lower Basalt Contacts

[ E" Output Volumes

The stratigraphic sequence object contains its own series of contact surfaces that can be
worked with in the same manner as contact surfaces that are created one-by-one.

If there were errors in the sequence, it would include a set of points that can be used in fixing
the errors. For example, here the stratigraphic sequence has errors, which appear in the project
tree as a pinch-out errors object ("#):

W (@ Surface Chronclogy

Stratigraphic Sequence [inactive]

“ Pinch-out Errors

# Coarse 5and - Alluvium Contacts

? Gravel - Coarse Sand Contacts
P % Glacial Till - Gravel Contacts
> f‘ Lower Gravel - Glacial Till Contacts
P & Aquifer Miocene Alluvium - Lower ¢
B # Basement Granite - Aquifer Miocend
P [ Output Volumes

These errors usually occur because a layer is not continuous, whereas Leapfrog Geo expects
that layersincluded in a stratigraphic sequence are continuous. Adding the pinch-out-errors
object (“#) to the scene displays the points that are causing errors. You can also find out more by
right-clicking on the stratigraphic sequence and selecting List Errors:

® Stratigraphic Errors X

Pinch-out Errors

The following lithologies are discontinuous and should be remaoved from the stratigraphic sequence

Ignored  Invalid Contacts Pinch-out Lithology

] 'Alluvium' touches 'Gravel' & times Coarse Sand

O ‘Lower Gravel' touches 'Basement Granite' 1times Aquifer Miccene Alluvium
Other Errors

Ignored  Error Message

O 'Coarse Sand' does not contact 'Gravel'

;; Help ‘%Qanca\ Qﬂg»{

Together with the pinch-out errors, this information can be used to decide what lithologies to
remove from the sequence or what surfaces to adjust.

However, for this tutorial there are no errors, and we can move on to the next step.
The sequence is not yet enabled in the model.
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10. Double-click on the Surface Chronology object.

11. Tick the box for the stratigraphic sequence to enable it:

12. Click OK.

13. Clear the scene.
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14. Add the model to the scene:
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Adding a Fault to the Model

The data for this tutorial includes a GIS line for a fault. We will now import the GIS line and add
the fault to the model.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Vector Data.
2. In the window that appears, select the Fault.shp file and click Open.

3. Inthe window that appears, click OK.

4. When prompted to filter data, select the Don't Filter Data option.

The line will be imported to the project:

« Theimported lineisadded to the GIS Data, Maps and Photos folder.

o Acopy of thelineisdraped onto the topography and added to the Draped GIS Objects
folder in the Topographies folder.

Now we can add the fault to the geological model's Fault System.

Each geological model is created with a Fault System object that is used to construct faults and
manage their interactions. Once the faults are active in the geological model, the geological
model will be divided into separate fault blocks, which will appear in the project tree as part of
the model.

5. Right-click on the geological model's Fault System and select New Fault > From GIS Vector
Data.

Two options are given for using the fault GIS line. Using the (On Topography) option makes
sense for GIS data as it is, by nature, on the topography. The (On Topography) option also

mitigates any issues that may occur if elevation information in the GIS data object conflicts with
thatin the project.

6. Select "Fault (On Topography)” and click OK:

& Select Vector GIS To Add

GIS Vector
e
vE
s Fault (On Topography)
=]

Fault

Fault Type
@) Surface () Vertical Wall

The GIS line will be added to the Fault System but is not activated in the geological model.
7. Double-click on the Fault System.

In the Fault System window, all faults defined for a model are listed and you can set
interactions between these faults. For this model, however, there is only one fault and no
interactions need to be set.
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8. Tick the box for the fault and click OK:

& Geological Model - GM

General Boundary | Fault System | Lithologies Chronology

Fault system chronology:

[] Faults
I%} Fault (On Topagraphy)

9. Once the geological model has been reprocessed, add it to the scene:

Plunge +45 o
Azimuth 045

1] 2500 5000 7500

Note that the way the geological model is organised in the project tree has changed now that
the fault has been activated:

v E‘ Geological Models
¥ [(# am
P @ Boundary
P &5 Fault System
b E—El Lithologies
¥ ) GM fault block 1
P (@ Fault Block Boundary
v @ Surface Chronclegy
> F Stratigraphic Sequence
[ 3 E Qutput Velumes
¥ ) GM fault block 2
P (@ Fault Block Boundary
v @ Surface Chroneclogy =
B § Stratigraphic Sequence
P [ Output Volumes
P [ Qutput Volumes

The geological model has been split into two fault blocks. Each fault block has its own Surface
Chronology, whereas the top-level geological model has none. The Surface Chronology for
one fault block can be modified without affecting other fault block.
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For geological models with a fault system, you can model the contact surfacesin two ways:

« Define the Surface Chronology before enabling the Fault System. All surfaces defined for
the unfaulted model will automatically be copied to each fault block. Some surfaces defined
for the model as a whole will not occur in every fault block, which can be corrected by
working with the surfacesin each fault block.

o Enable the Fault System before any surfaces are defined in the unfaulted model, then define
the Surface Chronology for each fault block. An aid to working with a faulted model in this
way is the ability to copy contact surfaces from one faulted block to another. To copy a
Surface Chronology from one fault block to another, right-click on the chronology you
wish to copy and select Copy Chronology To.

Which approach is best depends on the model being built. You may already know where the
faults are and choose to define them and subdivide the geological model before defining any
lithology layers. On the other hand, sometimes it is not apparent where the faults are until the
layers have been built, in which case you can add the new fault, activate itin the model, then
work with the surfacesin each fault block.

When working with fault blocks, it can be useful to rename them. For this model, we will
rename the fault blocks "north block” and “south block”.

10. Click on the model in the scene:

& GM: Granite =

e
Location 98604.4736, 0

197900.0000, -70.0834
Face dip 90
Fault Block GM fault block 2
Volume 51,142,000,000
Area 125,660,000 Plunge +41 @
Parts 2 Azimuth 035
1] 1000 Z000 3000

ﬁAdd Comments —

The name of the fault block is shown in the scene selection window.
11. In the project tree, find the fault block.
12. Right-click on the fault block and select Rename.

13. Enter the new name and click OK.
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Tutorial 4: Modelling a Complex Intrusion

In this tutorial, we will model a system of complex intrusions, which are shown in cross section
below:

[ Mineralised potassic alteration [} Seridtic alteration [l Porphyry stock
B Propylitic alteration B volznicedifice [l Basement
¥ Acid leached zone B Chloriticalteration [ Advanced argillic alteration

When a geological model is first created, it is a single volume of lithology “Unknown”. This
Unknown volume is divided up into known lithologies by creating contact surfaces. Contact
surfaces interact with other surfaces in different ways, and understanding how the contact
surfaces interact helpsin making decisions on how to model formations.

Types of contact surfaces are:

» Deposit contact surfaces. These do not cut older volumes. A volume defined by a deposit
contact surface will, therefore, appear conformably on top of older volumes.

« Erosion contact surfaces. These remove lithologies on the older side of the erosion contact
surface.

« Intrusion contact surfaces. These remove existing lithologies and replace them with the
intrusive lithology on the younger side of the contact surface. Often, the older side of an
intrusion contact surface is labelled "Unknown” as typically intrusions remove multiple older
lithologies.

« Vein contact surfaces. These remove existing lithologies and replace them with the vein
lithology within the boundaries defined by hangingwall and footwall surfaces and points
and a reference surface.
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Here, three deposit contact surfaces interact with two intrusion contact surfaces. The intrusion
contact surfaces are white (Unknown lithology) on the outside and the intrusive lithologies (11

and I2) on the inside:
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Intrusion contact surfaces result in rounder shapes than deposit and erosion contact surfaces,
which tend to be flat and sheet-like.

The difference between deposit and erosion contact surfacesis how they interact with older
lithologies.

o Depositsappear conformably on top of underlying older volumes and do not occurin
regions defined by older deposits.

« Erosions, however, remove existing lithologies on the older side of the erosion.

Here, two deposit contact surfaces divide a model volume (bounded by the pink box) into three
lithologies; each deposit (A, B and C) lies conformably on top of the previous one:

GM ]
A
B

| [

| [

-

Unknown

When a third deposit contact surface isadded, lithology D is deposited on top of lithologies B
and C:

GM a
A
B

[ [

| 3

| E

Unknown
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If, however, the third surface is an erosion contact surface, it cuts away the deposits on the older

side:
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GM [ >]
a
B

B

| B

B-

Unknown

An intrusion contact surface enabled in the model will remove the existing lithologies and
replace them with the intrusive lithology. Here, an intrusion surface (E) added to the model as

the youngest surface cuts away the older lithologies wherever it occurs:

& Geological Model - GM

General Boundary Fault System  Lithologies | Chronology

Contact surface chronology

Contact surface

M Unknown - E contacts
& C -D contacts

& B- C contacts

& A - B contacts

GM [ =]
A
B

[ [

B

B:

Unknown

Itis not necessary to model geological formations according to their corresponding contact
surface type. Often, the way you model a contact surface depends on the shape suggested by

the data and your knowledge of the geology of the area being modelled.

See the topic in the Leapfrog Geo online help for more information on the

different types of contact surface and how they interact.

Setting Up the Project

Data for this tutorial can be found in the Intrusion folder.
To start:

1. Launch Leapfrog Geo.

2. In the Projects tab, click New Project.

3. Enter the name “Intrusion tutorial” for the new project and click Browse to select a folder

where the project will be saved.
4. Click OKto create the project.

The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing a Map and Setting the Clipping Boundary

First, we willimport a map and use it to set the clipping boundary. The file is called map.tif.
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1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.
2. In the window that appears, select the file called map.tif, then click Open.

3. Click Import to import the map.

4. Add the map to the scene and press the D key to view it from above.

5. Right-click on the Topographies folder and select Set Clipping Boundary.

6. From the Enclose Object list, select <Everything>:
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7. Click OK.

Creating the Topography
Asin , we will create the topography from an elevation grid. The file
is called oamaru.asc.

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the oamaru.asc file and open the file.
3. In the Import Elevation Grid window, click Import.
4. In the New Topography window, click OK.

Importing the Drillhole Data

Data for this part of the tutorial can be found in the Intrusion > Drillholes folder. There are three
files:

« collar.csv contains the collar definitions.
« survey.csv containsinformation that describes the deviation of each drillhole.
« geology.csv contains the interval definitions that describes the lithology.

1. Right-click on the Drillhole Data folder and select Import Drillholes.
The Import Drillhole Data window will be displayed.

2. For Collar, click on the Browse button to locate the tutorial file collar.csv.
3. Click on thefile, then click Open.

All files have been added to the Input Files list.
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4. Click on Import to start the process of importing data.

5. Leapfrog Geo correctly maps the data in the collar and survey files, so click Next for each
one.

6. Forthe geology table, click on Finish to complete the process.
The data tables will be added to the project tree.

Analysing the Data

Once Leapfrog Geo hasimported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button (¥) to clear any objects from the scene window.

2. Add the geology table to the scene.

3. Click the Make lines solid button (%) to display the drillholes as cylinders.

4. Click the Show legend button (&) for the table.

5. In the shape properties panel, increase the Line radius to make the drillholes more visible.
6. Zoomin to get a better view of the data.

The scene should appear similar to this:
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The drillholes away from the centre of the data have two lithologies, Basement and Volcanic
edifice. These are the lowest layers in the model and we will model them as deposits.

7. Click the Edit Colours button.
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8. In the Legend window, hide the Basement and Volcanic edifice lithologies:

9. Click OK to dismiss the window.

@& Legend for lithology
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Advanced argillic alteration
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Porphyry stock
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Vaolcanic edifice
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10. Press the E key to view the scene looking east.

The two lithologies are hidden in the scene and it is easier to view the drillholes at the centre of
the data. Note that the legend in the scene has been updated to reflect the hidden lithologies:

¥ | B2 Projects | G Scene View

Flu-WN# [N E®S

T

+5002400

lithology
. Acid leached zone
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e _E| " gealogy

From oldest to youngest, the lithologies are:

11. Click the Edit Colours button.

Propylitic alteration

Mineralised potassic alteration

Porphyry stock
Sericitic alteration

Chloritic alteration

Advanced argillic alteration

Acid leached zone
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Keep the Legend window open and move it away from the scene window to view different
lithologies in the scene.
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12. In the Legend window, hide lithologies so that only the Propylitic alteration, Mineralised
potassic alteration and Porphyry stock lithologies are visible:

¥ | BS Projects | [ Scene View
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The propylitic alteration, mineralised potassic alteration and porphyry stock lithologies are
concentrated at the centre of the data. Because the drillhole data suggests a rounder shape for
these lithologies, we will model them as intrusion contact surfaces. These lithologies are
approximately the same age, but when we add them to the Surface Chronology, we need to
decide on an order. We can work from the outer edges of the model in, which is in the following
order:

« Propylitic alteration

o Mineralised potassic alteration
o Porphyry stock
The remaining lithologies are:

« Sericitic alteration

» Chloritic alteration

« Advanced argillic alteration

o Acid leached zone
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13. In the Legend window, hide lithologies so that the Acid leached zone, Advanced argillic
alteration, chloritic alteration and sericitic alteration lithologies are visible:

¥ | B2 Projects | [ Scene View
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These four lithologies are flatter and appear in more drillholes than the earlier intrusions, and
we can model them using deposit or erosion contact surfaces.

We will build this model by:
« Modelling the earliest lithologies, basement and volcanic edifice, as deposits.

« Modelling propylitic alteration, mineralised potassic alteration and porphyry stock lithologies
asintrusions.

« Modelling the remaining lithologies as a series of deposits and erosions.

Creating the Geological Model

To create the geological model:
1. Right-click on the Geological Models folder and select New Geological Model.

2. In the window that appears, change the following settings:

» Setthe Surface resolution to 20.

o Tickthe box for Adaptive.

o Fromthe Enclose Object dropdown, select the geology table.

3. Click OK to create the geological model.
The new geological model will be created in the Geological Models folder.

Modelling the Deposit Contact Surfaces

In , we saw that the oldest lithologies in the drillhole data are two deposits:
« Basement
« Volcanic edifice

The first contact surface we will create is the Basement contacts.
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1. Clear the scene.

2. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology.

3. Inthe window that appears, select “Basement” from the Select primary lithology dropdown
list.

We want to build a surface that represents the contacts between Basement and Volcanic
edifice and that excludes younger lithologies.

4. Drag the Sericitic alteration contacts and the Propylitic alteration contacts to the Ignored
lithologies list:

& New Contact Paints X

Lithology ' Compositing

Contact in Column "lithology’ on Table 'geclogy”

Query filter: Inherit frem GM
Select primary lithology
[ Basement v
® Use contacts above () Use contacts below

Contacting/Avoided lithologies: Ignored lithologies:

- Propylitic alteration (19) I:l Acid leached zone (0)
I:l Sericitic alteration (1) I:l Advanced argillic alteratio

- Voleanic edifice (39) - Propylitic alteration (19)
| Minera E potassic alterg
- Porphyry stock (0)
3
Treat unspecified intervals as
® Ignored ) Primary ) Contacting
Reference Plane

Horizontal plane

MName: [Basement contacts |

To select multiple itemsin windows and in the project tree, hold the Ctrl key or the Shift key
while clicking.

5. Click OK.

The new contact surface will appear in the project tree under the Surface Chronology.
6. Add the geology table to the scene.

7. In the shape list, click the Edit Colours button for the geology table.

8. Hide all lithologies except Basement and Volcanic edifice.
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9. Add the new contact surface to the scene and rotate the scene to view the drillholes and the

surface:

v | BB Projects | [ Scene View

F - WNE [N\ # S
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Slice mode: lFrom Scene -

Note that Leapfrog Geo has labelled the surface as Basement on the underside (the older side)

and Volcanic edifice on the top side (younger).
10. Clear the scene.
11. Double-click on the Surface Chronology.

12. Tick the box to enable the contact surface:

& Geological Model - GM

General Boundary Fault System Lithologies | Chrenology

Contact surface chronology

Contact surface
% Basement - Volcanic edifice contacts
a
Younger
Older
Background lithology: ll:l Unknown v

13. Click OK.

14. Once the changes have been processed, add the model to the scene.
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The contact surface has divided the Unknown volume into known lithologies Basement and

Volcanic edifice:

Morth ()

0

East ()

Plunge +20 @
Azimuth 030

250 500 750

Modelling the Intrusions

The next step is to model the propylitic alteration, mineralised potassic alteration and porphyry
stock lithologies. As discussed in , we will work from the outer edges of the

model inward:

o Propylitic alteration

« Mineralised potassic alteration
e Porphyry stock

1. Clear the scene.

2. Right-click on the Surface Chronology object and select New Intrusion > From Base

Lithology.
3. Inthe window that appears, select Propylitic alteration:

& New Intrusion

Lithology ' Compositing

Intrusion in column 'lithology’ on table 'geology’
Query filter: Inherit from GM
Select interior lithology

[@A(id\ea(hedmne v |
W Acid leached zone
I:l Advanced argillic alteration
- Basement
- Chloritic alteration
- Mineralised potassic alteration
- Porphyry stock
- Propylitic alteration
I:l Sericitic alteration
Tr- Volcanic edifice

® Ignore O Interior O Exterior

MName: [Acid leached zone ] |

';_;:ﬂelp x Cancel @QK

We need to move all younger lithologies into the Ignore (Younger lithologies) list. The easiest
way to do thisis to move all the lithologies into the Ignore (Younger lithologies) at once, then

add the lithologies we want to the Exterior lithologies list.
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4. Clickin the Exterior lithologies list.
5. On the keyboard, press Ctrl+A.
6. Drag all lithologies into the Ignore (Younger lithologies) list.

The lithologies in the Exterior lithologies list should be those that the intrusive body cuts
through, which will be the older lithologies.

7. Double-click on Basement and Volcanic edifice to add them back into the Exterior

lithologies list:

8. Click OK.

& New Intrusion

Lithelogy | Compasiting

Intrusion in column 'lithology’ on table "geoclogy®
Query filter Inherit from GM
Select interior lithology

-Pmpylitic alteration v

Ignore (Younger lithologies):

Exterior lithologies:

- Basement
- Volcanic edifice

e
l:l Advanced argillic alteration 7
- Chloritic alteration

- Mineralised potassic alteratic
- Porphyry stock

I:l Sericitic alteration

» ’

Treat unspecified intervals as

® Ignore O Interior O Exterior

Name: |Propylitic alteration l

b
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The new contact surface will appear in the project tree under the Surface Chronology.
9. Add the new contact surface () to the scene, together with the points (“#) and segments ()

used to create it.

It is coloured on the inside with the intrusive lithology and on the outside with the lithology

Unknown:

v | BB Projects [ Scene View

PR AN I N P

+5002500

e

o g =
] o g
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g o 2 3 b
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+ o E ] 3
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=
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@ M GM:Prration 3¢ [ Litholo...- || | — b 2 /A Propylitic alteration
@ 1 GM: Pro. fteration 3¢ —— Siice mod From s
ICE mode: rom scene v
<@ [\« Propyl...ration b4 |f\\ Propyli.~ H Edit Colours | — R B 3
Query filter: Mo Filter v

|

Thisis typical of intrusive lithologies as they contact multiple other lithologies on the outside.
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10. Repeat steps 2 to 9 for the Mineralised potassic alteration and Porphyry stock lithologies,
being sure to keep older lithologies in the Exterior lithologies list:

o Forthe Mineralised potassic alteration intrusion, the Exterior lithologies will be Basement,
Volcanic edifice and Propylitic alteration.

o Forthe Porphyry stockintrusion, the Exterior lithologies will be Basement, Volcanic edifice,
Propylitic alteration and Mineralised potassic alteration.

Itisa good idea to check each surface asis it created by adding the surface to the scene,
together with the data objects used to create it.

11. Clear the scene.

12. Add all new intrusions to the scene:

v == Projects | E’ Scene View

Fle-WNE RN ES

East (%)

+1441000

Plunge +&7 Q
Azimuth 028

0 250 500 750

@ W GM: M.ration 3¢ [@Litholo. - ||| |—— I BB # Propylitic alteration
@ W GM: Po... stock ® l:“:l S b Slice mode: [From Scene >
= GM: Proration 38 |@Litholo.. - || | Y e e

The Propylitic alteration appears geologically reasonable, but the other two surfaces do not.
We need to give them a more vertical appearance, and the best way to do this, in the absence of
additional data, isto apply a trend to the surface.

Often the easiest way to apply a trend is to position the moving plane in the scene and useitasa
reference plane for the trend we will apply to a surface.

13. Remove the Propylitic alteration and Porphyry stock contact surfaces from the scene.
14. Press the E key to view the scene looking east.
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15. Click on the Draw plane line button (#) in the toolbar and draw a line roughly vertical in the

scene:

F o WNE LANEBS

Elev (Z)

Plunge 00 o
Looking East
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e S—

@ [ GM: M...ration % [@Lthoo.~ || |——  Ibb =3 Bl No sclection

16. Rotate the scene to view the plane properly.

17. Click on the plane to view its controls and reposition it, if you wish:
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We now need to apply the settings from the moving plane to the contact surface.
18. Double-click on the contact surface in the project tree.
19. Click on the Trend tab.
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20. Click the Set From Plane button to copy the plane settings:

@& Edit Mineralised potassic alteration

Lithologies  Surfacing Inputs | Trend

Dip Dip Azimuth Pitch
Directions: ] .0 .90

Maximum  Intermed.  Minimum
Ellipsoid Ratios: |1 | 1

Wiew Plane Set From Plane Setto =

Name: |Mineralised potassic alteration ]

=

This copies the moving plane settings to the Trend tab.
The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,
where:

« The Maximumvalue is the relative strength in the direction of the green line on the moving
plane.

o Thelntermed. value is the relative strength in the direction perpendicular to the green line
on the moving plane.

o The Minimum value is the relative strength in the direction orthogonal to the plane.

To emphasis the vertical trend, we can change the Intermed. value.
21. Set the Intermed. value to 6.

22. Click OK.

When the surface is reprocessed, it should appear similar to this:

* | B8 Projects [ Scene View
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Now that we have adjusted the Mineralised potassic alteration surface, we can use the same
plane settings to adjust the Porphyry stock surface.

23. Clear the scene.
24. Add the Porphyry stock surface to the scene.

25. Double-click on the contact surface in the project tree.
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26. Clickon the Trend tab.
27. Fromthe Set to list, select the trend settings used for the Mineralised potassic alteration

surface:
=]
Lithologies Surfacing Inputs Trend
Dip Dip Azimuth Pitch o .
Directions: 0 L0 .90 .
0
Maximum  Intermed.  Minimum
Ellipsoid Ratios: |1 1 1
=1
-100 LS
| 3 I
View Plane Set From Plane _§Etto - § § i
9 |setropic %//
Name: |Porphyry stock vE o
. -1 [i Plunge +20
(@ Azimuth 030
F ve
L Help 100 200 300
M GM: Porphyry stock
,‘ GM: Mineralised potassic alteration
<= i GM: Po... stock 32 (& Litholo., M GM: Propylitic alteration irphyry stock
# GM: Basement - Violcanic edifice contacts
neerode: |From Scene -
28. Click OK.

Once the surface is reprocessed, it should appear similar to this:

Elev (Z

-
My

North (Y)
/sunznnn
|
1440000
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Plunge +20 @
Azimuth 030

0 100 z00 300
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29. Clear the scene.

30. Double-click on the Surface Chronology.
31. Enable each of theintrusions and click OK.
32. Add the geological model to the scene.
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The model should appear similar to this:
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Modelling the Younger Alterations

In Analysing the Data, we saw that the younger alterations form relatively flat layers. In this
step, we will model them as deposit and erosion contact surfaces. The remaining lithologies are:

« Sericitic alteration

» Chloritic alteration

« Advanced argillic alteration
» Acid leached zone

We will model these lithologies using alternating erosion and deposit contact surfaces. First, we

will model the Sericitic alteration contacts as an erosion.

1. Right-click on the Surface Chronology object and select New Erosion > From Base
Lithology.

2. Inthe window that appears, select Sericitic alteration.

3. Click Use contacts below.
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The younger lithologies should automatically appear in the Ignored lithologies list:

& MNew Contact Points

Litholegy | Compasiting

Contact in Column 'lithology’ on Table "geclogy’

Select primary lithology

“:l Sericitic alteration

() Use contacts ahove @) |Use contacts below

Contacting/Avoided litholegies: Ignored lithologies:

Query filter | Non, Inherit from GM

- Basement (1) - Acid leached zone (0)

- Porphyry stock (4) - Chloritic zlteration (0}
- Propylitic alteration (40)
- Volcanic edifice (2)

- Mineralised potassic alters I:l Advanced argillic alteratio

Treat unspecified intervals as
® Ignored O Primary ) Contacting

Reference Plane

Horizontal plane

MName: [SEricitic alteration contacts

l

4. Click OK.

5. Clear the scene.

6. Add the new surface to the scene.
It should appear similar to this:

North (Y)

+1440400

Next, we will enable the surface in the model.

+1441000
East ()

+1440600

Plunge +20 e
Azimuth 030
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7. Double-click on the Surface Chronology and enable the Sericitic alteration contacts surface.

8. Click OK
9. Clear the scene.
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10. Add the geological model to the scene:

Morth ()

East ()

Plunge +20 @
Azimuth 030

250 500 750

Next, we will create a deposit contact surface for the Chloritic alteration lithology.

11. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology.

12. In the window that appears, select Chloritic alteration.
13. Click Use contacts below.

14. Move all lithologies into the Contacted/Avoided lithologies list except Acid leached zone
and Advanced argillic alteration, as these are younger than the surface we are defining:

@& MNew Contact Paints

Lithelogy = Compositing

Contact in Column “lithology’ on Table "geclogy®
Query filter: Inherit from GM
Select primary lithology

I Chiaritic alteration v

() Use contacts above @ Use contacts below

Contacting/Avoided lithologies: Ignored lithologies:

- Basement (0} - Acid leached zone (0)
- Mineralised potassic alt I:l Advanced argillic alteratio
- Porphyry stock (0)

- Propylitic alteration (0) |

I:l Sericitic alteration (3) 5

Treat unspecified intervals as
@® Ignored ) Primary ) Contacting

Reference Plane
Horizental plane

Mame: | Chloritic alteration contacts ] |

For some of the lithologies we have included in the Contacting/Avoided lithologies list, there
are no contacts with the Chloritic alteration lithology. However, if the drillhole data is updated,
there could be contacts between Chloritic alteration and these other lithologies. Because
Chloritic alteration isyounger than these other lithologies, we need to move these lithologies
into the Contacting/Avoided lithologies list.

15. Click OK.
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16. Clear the scene.
17. Add the surface to the scene:

Morth ()

East (¥)

Plunge +20 e
Azimuth 030

0 250 500 750

18. Create an erosion contact surface for the Advanced argillic alteration lithology using these
settings:

« Selectthe Use contacts below option.

« Remove all lithologies except Acid leached zone from the Ignored lithologies list.

It should appear similar to this:
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19. Right-click on the Surface Chronology and select New Deposit > From Base Lithology.
20. Select Acid leached zone as the primary lithology and select Use contacts below.

As with the Advanced argillic alteration contact surface, there are older lithologies for which
there are no contacts with the primary lithology. However, updating the drillhole data could
result in contacts between these younger lithologies and the primary lithology and we would
wish the model to reflect this. Therefore, we need to move older lithologies into the
Contacting/Avoided lithologies list.

21. Move all lithologies into the Contacted/Avoided lithologies list.
22. Click OK.
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The surface should appear similar to this:
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23. Double-click on the Surface Chronology.
24. Enable all the contact surfaces and click OK.
25. Clear the scene.

26. Add the model to the scene.

It should appear similar to this:
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Tutorial 5: Building a Geological Model From a
Map

In this tutorial, we will create a geological model from an imported map using GIS lines and
structural data.

Data for this tutorial can be found in the Map folder.

Setting Up the Project

To start:
1. Launch Leapfrog Geo.
2. In the Projects tab, click New Project.

3. Enterthe name "GM from map” for the new project and click Browse to select a folder where
the project will be saved.

4. Click OKto create the project.
The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing a Map and Setting the Clipping Boundary

First, we will import a map and use it to set the clipping boundary. The file is called Simple fault
and sediments.tif.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called Simple fault and sediments.tif, then click
Open.

3. Click Import to import the map.

4. Add the map to the scene and press the D key to view it from above.

5. Right-click on the Topographies folder and select Set Clipping Boundary.
6. Adjust the red handles so the clipping boundary matches the map’s border:

Morth ()

& Set Clipping Boundary

Clipping Boundary
Minimum Maximurm

X (East:  p6.0s67282681)2 ) [3055.56032042

¥ (North): 38177626584 | [4075.223734152

Enclose Object v

()

%+ wlooking down
w

1] 1000 2000 3000

7. Click OK.
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Creating the Topography
Asin , we will create the topography from an elevation grid. The file
is called topo.asc.

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the topo.asc file and open the file.
3. In the Import Elevation Grid window, click Import.
4. In the New Topography window, click OK.

Creating the Geological Model

To create the geological model:
1. Right-click on the Geological Models folder and select New Geological Model.
2. In the window that appears, click OK to accept the default settings and create the model.

The new geological model will be created in the Geological Models folder. Because thereisno
drillhole data in the project, we need to manually define the lithologies used in the model.

3. Double-click on the Lithologies object.
4. In the Lithologies window, click the Add button to add a lithology:

& Geological Model - GM

General Boundary Fault System  Lithologies | Chronology
Code Colour
Unknown I:l

o s
;; Help %;ancel ("BQK

5. Name the lithology Red.
6. Add two more lithologies, Blue and Green.
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7. Foreach lithology, set the colour to match those in the map by clicking on the colour chip,
then using the eyedropper to pick the colour from the map displayed in the scene:

¥ | BB Projects | @ Scene View |
l

Sl W\ & [BN & &

@ Geological Model - GM

General Boundary Faukﬁys!em| Lithologies - Chrenalogy

EY

‘ Code

Unknown

Hue: | 228 _:

/ Saturation: | 131 :
Value: [178 |2
Color name:

&# Simple fault and sediments

. Slice mode: | From Scene

Eﬂe\p | [ Random

| xgancel _;

8. Click OK to close the Lithologies window.

Creating the Fault

We will create the fault by drawing a GIS line and structural data pointsin the scene.

1. Clear the scene.
2. Add the topography to the scene.

3. Fromthe GIS data dropdown list, select the imported map from the Maps and Photos
submenu to view it draped on the topography:

@ 4 Topography

o [@FAstcol..~ l:l = u_

b

GIS data: | Select -

Mone

Views

Maps and Photos

3
3 Simple fault and ;ed\msnt;l/\\)

4. Right-click on the GIS Data, Maps and Photos folder and select New GIS Line > From New

Drawing.

5. In the window that appears, name the line “Fault”.
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The new GIS line will be created in the project tree and will be added to the scene. Drawing

tools will be added to the scene window, and the slicer will be added to the scene to give the
drawn GIS line depth:

v [AEPriecs] @ scene vew
|

F e W F RN\ & & Se—
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|Nm'th ()
% Looking down o
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Planfsection +620.65
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® S Fauk [2ting] A X I —— - Svse 20 5] xfom [
Dip: 0.0 T ¥ [2680.00 =
Dip az.: 0.0 2z [620.6483154252 2
LS : |59 Full Acceleration 14FPs  $Z-Scale 1.0
6. To start drawing, click on the Draw lines button (+).
A set of tooltips appearsin the scene:
> [BB Proje:: [P Scene VI-E-'\:\-U-. |
& | tookw w[Ei@ h N\ & & %
B4.Faui.‘ x | & Select v 3 X @
Start 2D Line

» Click to start a new 20 line,
» Drag to start line and set curvature.
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7. Follow the tooltip instructions to trace the fault in the scene:
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~ | B8 Proje;; & Scene View | |
Fle-WNE N &2

Zafault b 4 [ Select » B
Dragging Curvature .,

» Release to set curvature,

Plan section +620.65

8. Right-click to end the drawing of the fault, then click the Save button.

9. Remove the GIS line and the slicer from the scene.

Next, we will add the fault to the geological model, then edit it with structural data points.

10. Right click on the Fault System for the geological model and select New Fault > From GIS

Vector Data.

When the Fault Type is set to Surface, the drawn GIS line will appear in the list twice. The Fault
(On Topography) option automatically drapes the drawn GIS line on the topography.

11. Select the Fault (On Topography) object and click OK.

12. Expand the Fault System in the project tree to see the new fault.
13. Right click on the fault and select Edit > With Structural Data:

¥ [ Geolagical Madels
¥ [# Gcm
P & Boundary
¥ &3 Fault System
P == Fault (On Tepegraphy

[ Mumeric Models T e

Fualiatinne
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A structural data table will be created and added to the project tree as part of the fault object.
The table will be added to the scene for editing and the structural data toolbar will appear,
together with the Structural Data window:

j@l s.f.v:éne\ﬁew | ‘
9’ Lookvw\@ @*\\g&?\f

Youngest

Oldest
N / Fault
= & Topogupny X @ e (B —— | g rast Om Topogrrty
e Smplefau: e Slice mode: From Scene v |
Fault_On_To..phy [Editing
— Show down dip lines

14. Zoom in to one of the structural data points on the map.
15. Rotate the scene so that you are looking in the direction of the dip.
16. Change the plunge until itis about the same as the dip.

17. Click on the structural data point button (**) and draw the data pointin the scene. To do
this, click on the centre of the strike and dip, and drag to the right:

¥ | BB Projects | (@ Scene View | ‘

F - WNE YNE N ¢ L X Sy

T v, %

Planar Structural Data

® 4 Topography ® @Fetcol|[ M ——
GIS data: [ Simple faul...» —

. Fault_On_Topography

Slice mode: Ime Scene | v |

Show down dip lines

Always drawing structural data points in the same direction ensures the polarities remain
consistent.
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18. In the Structural Data window, manually enter the Dip value from the map:

v [ | @ scenevi | |
Fle-WNE XNEIN 9 BHX S

Point:

w

East (0: 2063665784257 | %
North(v: [1038.122002602 3
Elev. (2 535.801000378¢ 3|

Dip Azimuth: | 282,83 &l

Dip:

Elip Point |

| Delete Point

. Fault_On_Topography

Slice mode: [From Scene | v

@ g Topography 8 (@Fatcol.r|[ [l ——
GIS data: - Simple faul...~ e |

Show down dip lines

19. Draw the second structural data point that occurs along the fault and edit its dip value.
20. Click the Save button.

21. To enable the fault, double-click on the Fault System.

22. Tickthe box to enable the fault.

23. Click OK.

The geological model has now been divided into two fault blocks, named “GM fault block 1"
and “GM fault block 2™

¥ [ Geclogical Models
v (# oM
[ Boundary
¥ &3 Fault System
P == Fault (On Topography)
i—El Lithologies
¥ £ GMfault block 1
P (@ Fault Block Boundary
@ Surface Chronology
P [ Qutput Volumes
¥ ) GM fault block 2
P (@ Fault Block Boundary
@ Surface Chronology
[ 3 E Output Velumes ]
[ 3 E‘ Output Volumes

We can rename these volumes to make them easier to work with.
24. Clear the scene.

25. Right-click on the geological model in the project tree and select View Fault Block
Boundaries.

26. Press the D key to view the model from above.
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27. Click on the eastern side of the geological model:

Narth ()

@ cm fault block 1: Fault Block
Boundary

Location 3071.4949, 3510.0000,
616.5462
Volume 4,903,300,000 z
Area 23,516,000 B Lacking down 0
Parts 1 =
0 1000 2000 3000
“Add Comments

This shows that the fault block on the eastis "GM fault block 1"

28. Right-click on the fault block in the project tree and select Rename.
29. Rename the fault block “East”.

30. Rename the other fault block "West".

Creating the Contact Boundary Meshes

The contacts will be created using GIS lines. We could draw them from the map, as we did for
the fault, but for this step, we will import the GIS lines and use them to create meshes. We will
then edit each mesh using the structural data point for each contact boundary.

1. Tostart, clear the scene.
2. Right-click on the GIS Data, Maps and Photos folder and select Import Vector Data.
3. Select the four shape files and click Open:

o blue_green_east.shp
« blue_green_west.shp
o red_blue_east.shp
o red_blue_west.shp

4. In the Import GIS Vector Data window, click OK.

5. Click Don't Filter Data.

The imported GIS lines will be added to the GIS Data, Maps and Photos folder.
Next, we will create four meshes, starting with the blue_green_east mesh.

6. Right-click on the Meshes folder and select New Mesh > From GIS Vector Data.
7. Inthe window that appears, select the blue_green_east (On Topography) GIS line.
8. Click OK to accept the other settings and create the mesh.

Next, we will add a structural data point to the mesh.

9. Add the topography to the scene.

10. Orient the scene to draw the structural data point along the blue_green_east boundary.
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11. Right-click on the mesh and select Edit > With Structural Data:

¥ [ Meshes
& topo
[ 3 @ blue_green_east (On Top/ D;Jen ﬂ Mo Comments
¥ [ Geological Models i Add N - .
V7 Gm Edit v | Zq With Polyline
P @ Boundary Drape Image + || @ With Structural Data

¥ &3 Fault System

R Evaluations
-
__l Fault (On Topogra 5] Extract Mesh Parts...,
=| Lithelogies 2
%., Extract Vertices
v : -
st [] View Object xi& |:
B (@ Fault Block Bound| e
? Surface Chronolog * Prioritise
[ 3 E‘ Qutput Velumes Rename... F2
W ) West g Delete... Delete

P (@ Fault Block Bound; §” Export...
@ Surface Chronolog (§” Export Elevation Grid..

P [ Output Volumes 7] Properties...
e T e =T

12. Zoomiin to the structural data point on the map.

13. Click on the structural data point button (**) and draw the data pointin the scene.
14. In the Structural Data window, manually enter the Dip value from the map.

15. Click the Save button.

16. Repeat the above steps for each imported GIS line.

Adding the Contact Surfaces to the Geological Model

Now that we have created the GIS lines that represent the contact boundaries, we can start
adding contact surfaces to the geological model. The geological model has been divided into
two fault blocks, East and West, so we need to define the surface chronology for each fault
block. We will do this working from the oldest contacts to the youngest, which means that for
each fault block we will define:

« A Green-Blue surface
o« ABlue-Red surface

1. Clear the scene.

2. Right-click on the Surface Chronology for the East fault block and select New Deposit >
From Surface.

¥ [ Meshes |
. |
2 tope Open $ No Comments
[ ] blue_green_east (On Topog
[ ] blue_green_west (On Tepe -

P & red_blue_east (On Topogra # New Deposit b
b red_blue_west (On Topogr: " :EW:*ETS‘U_” 4 "CE i oo
i B New Intrusion 4 From Polyline...

Y ?[G;OGI:AQKEI ot % New Vein + | %2 From GIS Vector Data..
P @ Boundary %% New Structural Surface " From Structural Data...
¥ g Fault System % New Vein System #:. From Points..

ZF New Stratigraphy X From Offset Surface...

P == Fault (On Topograpk
E‘ Lithologies
v ﬂ East f Prioritise
» J Fault Block Boundan| 7] Bropertics.. % [@Fat col..~[
(# Surface Chrenology IS data: [Q[simple faul...~
» [ Output Volumes || ® @ blue_green_e.._Topography #* 3¢ [@ Flat colr]|
v |
£ west || @ @ blue_green_w..._Topography 2/ 32 [@ Flat col.-]|
P (@ Fault Block Boundary
p || ® @ red blue east.. T h
@ Surtace Chronslogy @ red_blue_east.._Topography #” 3£ & Flat co [
» B Output Volumes ® @ red_blue_wes... Topography /* 38 & Flat col...-||
P [ Output Volumes

View All & From Surface...
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3. Inthe window that appears, select the blue_green_east (On Topography) mesh.
4. Set Blue for the First lithology.

5. Set Green for the Second lithology.

6. Ensure that First lithology is set to be younger than the Second lithology:

@& New Depositional Contact

Select surface
&4 blue_green_east (On Topography)
Select lithology

Firstlithology: [ Blue v | [isVounger | »
Second lithology: -Greeﬂ ¥ | is Older

Mame: |Green - Blue contacts I

;; Help %gance\ Qﬂg»{

7. Click OK.

Once the surface has been created, we can add it to the scene to check its orientation.
8. Add the contact surface to the scene.

9. Add the topography to the scene.

10. Orient the scene to see whether or not the colours assigned to each side correspond to
those on the map.

If the surfacesis not oriented correctly, as in the image below, click the Swap Younging
Direction button:

& Edit Green - Blue contacts

Lithologies | Surfacing  Trend
Eirst lithology: -Blue - [\sYoungar -
Second lithology: |[IIl Green v | is Older

@.Swap Younging Direction | JContact Type: IDeposit v

MName: [Green - Blue contacts I

Plunge +08& @
Lzimuth 311
P L& Do 50 375 500

11. Repeat these steps for each contact, creating the surfaces west of the fault using the
Surface Chronology for the west fault block.
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12. Add the four surfaces to the scene. They should appear similar to this:

Plunge +39 @
Azimuth 338

o 500 1000 1500 2000

If your results are not expected:

« Checkthatthe surfaces are oriented correctly and change the younging direction, if
required.

« Editthe structural data point used to edit each mesh. To do this, expand the mesh in the
project tree. Right-click on the structural data table and select Edit In Scene.

Enabling the Contact Surfaces

Although the contact surfaces have been defined, we still need to enable them.
1. Double-click on the Surface Chronology for the East fault block.

2. Enable both contact surfaces and click OK.

3. Repeat the process for the West fault block.

4. Clear the scene.

5. Right-click on the geological model and select View Output Volumes:

Plunge +20 @
Azimuth 030

1] 500 1000 1500 2000
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